Digital Photo Professional
Ver. 4.0
Instruction Manual

Content of this Instruction Manual
- DPP stands for Digital Photo Professional.
- In this manual, the screens used in the basic operation instructions are from Windows 8.1.
- ▶ indicates the selection procedure of the menu.
- Square brackets are used to indicate items such as menu names, button names and window names that appear on the computer screen.
- Text inside < > indicates a key on the keyboard.
- p.** indicates a reference page.
- Click to move to the relevant page.
- Advanced indicates the function for advanced users who are experienced in handling image processing software.
- ❓: Marks helpful information when a problem arises.
-💡: Marks tips for using the software skillfully.
-⚠️: Marks information that should be read before use.
-📝: Marks additional information you may find helpful.

Switching Between Pages
- Click on arrows on the bottom right of the screen.
  - : next page
  - : previous page
  - : return to a page you had previously displayed
- Click on the chapter headings on the right side of the screen to switch to the contents page of that chapter. Also, click the item you want to read about on the table of contents to move to the relevant page.
READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single computer. You may physically transfer the SOFTWARE from one computer to another provided that the SOFTWARE is used on only one computer at a time. You shall not install or use the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware configuration where the SOFTWARE is accessible to more than one CPU or to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for use of the SOFTWARE. No updates, fixes or support will be made available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, maintain and match the hardware and software components of your computer system. Thus Canon does not guarantee uninterrupted service or correction of errors or that the functions or performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material under normal use for a period of ninety (90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same without charge when returned by you at your expense to your point of purchase and proven to be defective upon inspection. The replacement CD-ROM will be warranted for the remainder of the original ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE USE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate without notice to you if you fail to comply with any of the terms of this Agreement and you must then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in the United States of America shall be governed and construed in all respects in accordance with the laws and regulations of the State of New York, without reference to choice of law principles. The terms of this Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of the SOFTWARE is subject to the United States, Canada and other applicable copyright and trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its affiliated corporations and third party licensors under such laws. Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any images, graphics or textual material that you save in connection with the Software.

10. ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
Main Features of DPP

Following are the main tasks you can perform with images you have downloaded to your computer.
• JPEG/TIFF indicates processing that can be performed with JPEG or TIFF images as well as RAW images.

- View and organize images
- Adjust an image
  - Various image adjustments while maintaining the original image
  - Freely apply a Picture Style
  - View your image before and after adjustment in the same window
- Trim and adjust the angle of an image (trimming)
- Resize an image
- Correction of lens aberration
- Digital Lens Optimizer
- Automatic/manual dust erasure processing
- Convert from a RAW image to a JPEG or TIFF image and save
  - Process large numbers of RAW images in batches
  - Transfer the image to image editing software
- Print an image
- Link with EOS Utility for remote shooting
- Color management compatibility
  - CMYK simulation for commercial printing

System Requirements

- OS (operating system): Windows 8.1 (64 bit)*1, Windows 8 (64 bit)*1, Windows 7 (64 bit)*1
  - *1 Will not run on 32-bit versions.
- Model: PC with one of the above OS preinstalled
  - *2 With Microsoft .NET Framework 4.5 installed
- CPU: Core 2 Duo 2.0 GHz or higher (recommended Core i series or later)
- RAM (memory): 2.0 GB or more of RAM (4.0 GB or more recommended)
- Hard disk drive: Installation: Min. 200 MB of available space
  - Operation: Min. 256 MB of available space
- Display: Resolution: XGA (1024 x 768) or more (1600 x 1200 or more recommended)
  - Colors: 16 bit color (65536 colors) or more

Supported Cameras

EOS-1D X, EOS-1D C, EOS 5D Mark III, and EOS 6D

Supported Images

Image data

<table>
<thead>
<tr>
<th>Image type</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Still photos</td>
<td>RAW images</td>
</tr>
<tr>
<td>JPEG images</td>
<td>Exif 2.2, 2.21 or 2.3-compatible JPEG images</td>
</tr>
<tr>
<td>Movies</td>
<td>MOV movies shot on supported cameras</td>
</tr>
</tbody>
</table>
# Contents

## 1 Downloading Images .............................................. 6
Starting up DPP .......................................................... 7
  Downloading Images to Your Computer ....................... 8
    Downloading Images Using the Software “EOS Utility” ............. 8
    Downloading Images Using Your Card Reader........ 8

## 2 Viewing Images ...................................................... 9
Viewing Images in the Main Window (Thumbnail Layout) ........................................... 10
  Changing the Thumbnail Display ................................ 10
Enlarging and Viewing an Image in the Preview Window ............................................. 13
  Enlarging and Viewing a Specific Area ......................... 13
  Checking the Image in Detail ....................................... 15
Displaying the Main Window (Multi-layout) ......................... 15
Checking an Image Using the Preview Control Panel ............................................... 16
Checking an Image in Multi-Function Preview ...................... 20
Checking an Image in Second Windows ......................... 21
Opening and Closing Window Panels (Panes) ..................... 22
Changing the Display Method and Order of Palettes ............. 23
Changing the Display Method (Dock/Float) of Palettes ............. 23
Rearranging Palettes ............................................. 23
Exiting DPP .......................................................... 24

## 3 Organizing and Sorting Images ...........................  25
Efficiently Checking/Sorting Images ................................ 26
Sorting Images ....................................................... 28
Sorting Images in the Main Window ............................... 29
Arranging Images in the Main Window .............................. 30
Displaying a RAW Image and JPEG Image as a Single Image ........................................... 31
Checking Image Information ........................................ 32
Organizing Images ..................................................... 34
Deleting an Unwanted Image ................................ ....... 34
Moving Images .......................................................... 34
Moving Images in Folders ........................................... 35
Registering Frequent-Use Folders (Bookmark Registration) ........................................... 35

## 4 Editing Images .....................................................  36
RAW Images .............................................................. 38
  RAW Images .......................................................... 38
  RAW Development ...................................................... 38
  When RAW Development is to be Done ......................... 38
  Advantages of a RAW Image ......................................... 38
Editing JPEG and TIFF Images ...................................... 39
  Tool Palettes .......................................................... 40
Editing with the Basic Adjustment Tool Palette .............................................. 41
  Adjusting Brightness .............................................. 41
  Changing the Picture Style ....................................... 42
  Using a Picture Style File ......................................... 43
  Adjusting Color Tone by Changing White Balance ......................... 43
  Adjusting Color Tone Using Click White Balance ......................... 44
  Adjusting White Balance with Color Temperature ......................... 45
  Tuning White Balance ........................................... 45
  Adjusting Contrast ................................................. 46
  Adjusting Brightness of Shadows/Highlights .................................... 46
  Changing Color Tone and Color Saturation .................................... 47
  Adjusting Dynamic Range ......................................... 48
  Adjusting Gradation and Luminance Automatically ......................... 49
  Using the Auto Lighting Optimizer ..................................... 50
  Adjusting Image Sharpness ........................................ 51

Editing with the Tone Adjustment Tool Palette .............................................. 53
  Adjusting Brightness and Contrast ..................................... 53
  Adjusting Color Tone Using Click White Balance ......................... 54
  Adjusting Tone Curve ............................................. 55

Advanced Adjusting Dynamic Range ........................................... 57
Using the Auto Lighting Optimizer ........................................... 57

Editing with the Color Adjustment Tool Palette .............................................. 58
  Adjusting Dynamic Range ......................................... 58

Advanced Editing with the Color Adjustment Tool Palette ......................... 58
  Reducing Noise ..................................................... 60
  Adjusting Image Sharpness ........................................ 61

Editing with the Detailed Adjustment Tool Palette ........................................... 60
  Editing with the Trimming/Angle Adjustment Tool Palette ......................... 62
  Editing with the Lens Correction Tool Palette ..................................... 65
  Correcting Lens Aberration ......................................... 65
  Compatible Lenses ............................................... 65
  Making Corrections .................................................. 67
  Shooting Distance Information Slider .................................... 69
  Correcting Multiple Images at a Time .................................... 70
  Digital Lens Optimizer ............................................ 70
  Compatible Lenses ............................................... 70
  Using the Digital Lens Optimizer ..................................... 71
  Adjusting Image Sharpness ........................................ 73

Editing with the Dust Delete/Copy Stamp Tool Palette ........................................... 74
  Performing Automatic Dust Erasure Processing ......................... 74
  Automatic Dust Erasure Processing in the Main Window ......................... 75
Contents

1 Introduction

2 Downloading Images

3 Viewing Images

4 Sorting Images

5 Editing Images

6 Processing Large Numbers of RAW Images

7 Remote Shooting

8 Specifying Preferences

9 Reference/Index

1 Contents

1.1 Introduction

1.2 Downloading Images

1.3 Viewing Images

1.4 Sorting Images

1.5 Editing Images

1.6 Processing Large Numbers of RAW Images

1.7 Remote Shooting

1.8 Specifying Preferences

1.9 Reference/Index

1.10 Manually Erasing Dust (Repair Function).............. 76

1.11 Erasing Unwanted Parts of an Image (Copy Stamp Function)....................................................... 78

1.12 Setting Work Color Space .................................. 79

1.13 JPEG/TIFF Saving Editing Results.......................... 80

1.14 JPEG/TIFF Saving Editing Contents to an Image .... 80

1.15 JPEG/TIFF Saving as a separate image .................. 80

1.16 JPEG/TIFF Re-Editing an Image ................................ 82

1.17 JPEG/TIFF Utilizing Adjustment Contents (Recipe) 83

1.18 JPEG/TIFF Copying a Recipe and Applying to Another Image 84

1.19 JPEG/TIFF Saving a Recipe as a File ...................... 84

1.20 JPEG/TIFF Loading and Applying Recipes .............. 85

1.21 JPEG/TIFF Adjusting by Comparing Multiple Images ............... 86

1.22 JPEG/TIFF Editing Efficiently ............................... 87

1.23 JPEG/TIFF Editing in the Edit Image Window ........... 87

1.24 JPEG/TIFF Changing the Thumbnail Display Position to Horizontal .................................................. 88

1.25 JPEG/TIFF Gathering and Editing Images in the Collection Window .................................................. 88

1.26 Advanced Transferring a RAW Image to Photoshop 91

1.27 Advanced Customizing the Main Window Toolbar .... 92

1.28 Printing Images .................................................. 93

1.29 Printing an Image ................................................ 94

1.30 Printing with Shooting Information ...................... 95

1.31 Printing ........................................................... 96

1.32 Processing Large Numbers of RAW Images ......... 97

1.33 Batch Apply White Balance to Images (Personal White Balance) ................................................. 98

1.34 Registering Personal White Balance .................... 98

1.35 Applying Personal White Balance ........................ 99

1.36 Batch Save as JPEG or TIFF Images (Batch Processing) .............................................................. 100

1.37 Batch Transfer Images to Image Editing Software 102

1.38 Batch Change the File Name of Images ............... 103

1.39 Changing the File Name of Images in the Order in the Main Window ............................................. 103

1.40 Remote Shooting ............................................... 104

1.41 Remote Shooting .............................................. 105

1.42 Specifying Preferences ....................................... 108

1.43 Specifying Preferences ....................................... 109

1.44 General Settings ................................................ 109

1.45 Image processing ............................................. 110

1.46 Color Management ............................................ 111

1.47 View Settings ................................................... 112

1.48 Reference .......................................................... 113

1.49 Troubleshooting .................................................. 114

1.50 Deleting the Software (Uninstalling) ..................... 115

1.51 Image Frame Information in the Main Window and Edit Image Window .......................................... 116

1.52 Glossary ........................................................... 117

1.53 Index ............................................................... 119
1 Downloading Images

Starting up DPP .......................................................... 7
Downloading Images to Your Computer ...................... 8
  Downloading Images Using the Software “EOS Utility” .... 8
  Downloading Images Using Your Card Reader ............ 8
Starting up DPP

Double-click the desktop icon.

→ DPP starts up and the main window (thumbnail layout) appears.

If you drop a DPP-supported image file onto the icon on the desktop, you can start up DPP and display the folder where the image file is saved.
**Downloading Images to Your Computer**

Download the images saved on the memory card inserted in the camera.

---

**Downloading Images Using the Software “EOS Utility”**

You can download images with “EOS Utility”, communication software for the camera.

For detailed instructions on downloading images, refer to the “EOS Utility Instruction Manual” (PDF electronic manual).

---

**Downloading Images Using Your Card Reader**

You can also download images to the computer using a third-party card reader.

1. **Load the memory card into the card reader.**
   - Start up DPP beforehand.

2. **Open [My Computer] ➤ [EOS_DIGITAL] and drag the [DCIM] folder to the [Desktop].**

   ➔ The [DCIM] folder is copied to your computer.

   - All images are saved in folder units inside the [DCIM] folder.
   - Copying images to your computer will take some time when there is a large number of images saved on the memory card.
2 Viewing Images

Viewing Images in the Main Window (Thumbnail Layout) .......... 10
Changing the Thumbnail Display ........................................ 10
Advanced Using the Thumbnails Control Panel ......................... 11
Advanced Displaying the Histogram Palette ............................ 12
Enlarging and Viewing an Image in the Preview Window ............ 13
Enlarging and Viewing a Specific Area .................................. 13
Displaying the Navigator Palette ........................................... 14
Advanced Checking the Image in Detail .................................. 15
Displaying the Main Window (Multi-layout) ............................ 15
Checking an Image Using the Preview Control Panel .................. 16
Changing the Magnification ................................................... 16
Comparing with a Pinned (Fixed) Image .................................. 16
Displaying Multiple Images ................................................... 17
Displaying Grid Lines ........................................................... 17
Displaying AF Points .......................................................... 17
Displaying Areas Beyond the Set Range with Warning Indicators (Highlight/Shadow Warning) .......................... 18
Comparing Pre- and Post-Editing Images (Single-Image Display) ................................................................. 18
Comparing Pre- and Post-Editing Images (before/after comparison) Arrange vertically/horizontally (two-screen display) / Split vertically/horizontally (split-image display) ................................................................. 19
Displaying Image Properties ..................................................... 19
Checking an Image in Multi-Function Preview ......................... 20
Checking an Image in Second Windows ..................................... 21
Opening and Closing Window Panels (Panes) ......................... 22
Changing the Display Method and Order of Palettes .................. 23
Changing the Display Method (Dock/Float) of Palettes ............... 23
Rearranging Palettes .......................................................... 23
Exiting DPP ............................................................................ 24
Viewing Images in the Main Window (Thumbnail Layout)

Images downloaded to your computer are displayed as a thumbnails list in the main window (thumbnail layout). You can double-click an image to open the preview window (p.13) and display the image at large size.

Changing the Thumbnail Display

You can change the size of the thumbnail images displayed in the main window and select the information displayed for thumbnails.

Select the [Thumbnails] menu ➔ desired item.

- The display changes to the selected item.
- To display thumbnails with shooting information attached, select the [Tools] menu ➔ [Settings for thumbnails with shooting info].

Main window

- Toolbar

- Ratings (p.28, p.29)
- Check marks (p.28, p.29)
- Forward/Reverse
- Rotate image

- If you double-click on the movie file, the movie playback application specified with the computer’s OS settings will start up and play back the movie. Note that edited movies will not be played back.
- When aspect ratio information is attached to the shot image, the image is displayed as a cropped image (p.62).
- In the main window, in addition to this view (thumbnail layout), you can select multi-layout. Multi-layout allows you to check the image in detail (p.15).

COPY

COPY
Using the Thumbnails Control Panel

The thumbnails control panel integrates various settings for viewing thumbnails. By using this panel, you can view and specify the settings for thumbnails efficiently.

Thumbnails control panel functions

1. Change the size of thumbnails
2. Display thumbnails without file names
3. Display standard thumbnails
4. Display thumbnails with information
5. Select information to display for thumbnails
6. Display a RAW image and JPEG image as a single image

Display a RAW image and JPEG image that were shot together as a single image. When this setting is specified, viewing and editing of images are as follows.

- **Image displayed**: Only the RAW image is displayed in all windows.
- **Edited image**: The content which has been edited with any of DPP’s functions (the tool palette etc.) will be applied to the RAW image only. However, if you have used the following functions, the adjustments will be applied to both the RAW image and the JPEG image.
  - Deleting an image (p.34)
  - Moving or copying an image (p.34)
  - Checkmarking (p.28 to p.29)
  - Rating (p.28 to p.29)
  - Rotating an image (p.10)

7. Select all thumbnails
8. Cancel all thumbnail selections
9. Turn on/off thumbnail display filter
10. Specify filtering option for thumbnail display filter
11. Specify option for sorting thumbnails
12. Select order (ascending/descending) for sorting thumbnails

- The thumbnails control panel is displayed in the main window by default. If it is not displayed, such as when screen settings have been changed, you can display it by selecting [Thumbnail control panel] in the [Thumbnails] menu.
- In multi-layout (vertical thumbnails, p.15), only the thumbnail view settings (Default thumbnail display/Show thumbnails without file names) are possible.
Displaying the Histogram Palette
The histogram palette shows a histogram of the selected image. You can quickly check a histogram without opening a tool palette.

Select the [View] menu ➤ [Histogram palette].
→ The histogram palette appears.

You can select any of the following four histograms from the menu that appears when you right-click with the mouse.
[Brightness only], [RGB separately], [YRGB separately], [RGB together]
Enlarging and Viewing an Image in the Preview Window

The preview window appears.

> The area you clicked is enlarged to 100% (actual pixel size).
> Click again to revert to the full view.
> To change the display area drag on the image.

**Double-click**

- Click the area you want to enlarge.
- Click in the upper right of the preview window to close the preview window.

**Tool palette**

- Select any enlargement ratio from the [Preview] menu.

**Preview window**

- By selecting the [Preview] menu ➤ [AF points] in the preview window, you can display the AF points selected in the camera at the time of shooting. However, AF points are not displayed for images whose image size has been changed and then been converted and saved (p.80), images for which you selected an effect other than [Shot settings] as correction of fisheye lens distortion aberration, or images which have had settings specified during RAW processing on the camera for distortion correction or chromatic aberration correction.

To display an image in an enlargement ratio other than 100%

Select any enlargement ratio from the [Preview] menu.

While in the preview window, you can select the [Preview] menu ➤ [Preview control panel] to use various preview functions. For details, see “Checking an Image Using the Preview Control Panel” (p.16).
Displaying the Navigator Palette
The navigator palette shows the enlargement area of a selected image.

Select the [View] menu ▶ [Navigator palette].
→ The navigator palette appears.

When an image is enlarged in the preview or other window, the enlargement display area is indicated in the navigator palette. The area to be enlarged can be changed by dragging the enlargement display area on the image.

Change the enlargement display area by dragging.
Checking the Image in Detail

Displaying the Main Window (Multi-layout)
By switching the main window to “multi-layout”, you can use the preview control panel to check the image in detail.

Click a change layout button at the bottom of the main window (thumbnail layout).
→ The main window (multi-layout) appears.
• In the main window (multi-layout), you can select from two layouts, with horizontal thumbnails or vertical thumbnails.
• Click the area you want to enlarge in the image displayed in the preview display area to display the image at actual pixel size (100%). Click the image again to revert to full display.

Main Window (thumbnail layout)

Multi-layout (horizontal thumbnails)

Multi-layout (vertical thumbnails)
Checking an Image Using the Preview Control Panel

With Preview control panel, you can check the image in detail. You can use this panel in the main window (multi-layout) and edit image window. If the preview control panel is not displayed, you can display it by selecting [Preview control panel] from the [Preview] menu. By default, the [ ] button and [ ] button are selected.

Changing the Magnification

Display the image at actual pixel size (100%).

Click the [ ] button to display the image at the set magnification displayed. If the [ ] button is used to enlarge/reduce the image, the magnification set for this button also changes accordingly*.

*Excluding actual pixel size (100%)

Enlarge/reduce the image.

Revert the zoomed image back to fit-to-window view.

Comparing with a Pinned (Fixed) Image

You can split the window into two sections, and compare the images on the left and right by “pinning” an image in the left section then scrolling images in the right section. It improves efficiency of image selection.

Select an image and click the [ ] button.

The window divides into left and right, and the selected image is pinned.

When you pin an image and perform scrolling, the image on the left (pinned image) remains and only the image on the right is scrolled, which is convenient for image selection.

To pin another image, select the image, then select [Pin] from the menu that appears when you right-click with the mouse.

After pinning an image, you can click the [ ] button to switch between top-bottom and left-right split screens.
Displaying Multiple Images

Select multiple images, and click the [ ] button.

→ The selected image is displayed.
● You can display up to 8 images.

Displaying Grid Lines

1 Click the [ ] button beside the [ ] button, and set the spacing between grid lines on the menu that appears.

● To set the spacing, enter values (8 to 256, in pixels), or move the slider.
● After specifying settings, click the [Close] button and close the window.

2 Select an image and click the [ ] button.

→ The image with grid lines is displayed.

Displaying AF Points

1 Click the [ ] button beside the [ ] button, and select the item to display on the image on the menu that appears.

● Select [Show only AF points in focus] or [Show all AF points].
● After specifying settings, click the [Close] button and close the window.

2 Select an image and click the [ ] button.

→ An image with the AF points selected in step 1 is displayed.

AF points are not displayed for images whose image size has been changed and then been converted and saved (p.80), images for which you selected an effect other than [Shot settings] as correction of fisheye lens distortion aberration, or images which have had settings specified during RAW processing on the camera for distortion correction or chromatic aberration correction.
Displaying Areas Beyond the Set Range with Warning Indicators (Highlight/Shadow Warning)

You can set up warning indicators for both highlighted and shadowed parts, which is effective for checking the clipped highlights and shadows and preventing excessive adjustment of an image. Where the area on the image has exceeded the set range, you can display the highlighted part in red and the shadowed part in blue.

1. Click the [ ] button beside the [ ] button, and specify settings on the menu that appears.

   - Checkmark the [Show highlight warnings] and [Show shadow warnings] checkboxes and enter the warning values.
   - You can also select different warning colors from the dialog that appears when you click the [ ] button.
   - After specifying settings, click the [Close] button and close the window.

2. Select an image and click the [ ] button.

   - On the opened image, if there is an area that exceeds the value entered in step 1, the highlighted part of that area is displayed in red and the shadowed part is displayed in blue. If you selected different warning colors, the parts are displayed in the specified colors.

Comparing Pre- and Post-Editing Images (Single-Image Display)

Select an image that is being edited and click the [ ] button.

- By clicking the button, the display switches between the image before editing and the current image (being edited).
Comparing Pre- and Post-Editing Images
(before/after comparison) Arrange vertically/horizontally (two-screen display) / Split vertically/horizontally (split-image display)

You can display before and after versions of an adjusted image in the same window and check the adjustment results.
This function allows you to adjust an image while comparing the original image and image being edited.

1 Select an image that is being edited and click the [ ] button.

The image is displayed in two-screen display (Arrange vertically).
The image before editing is on the left, and the currently edited is on the right.

2 Change the image display.
The display switches in the following order by clicking the [ ] button.

Displaying Image Properties

Display the shooting and recipe information for an image in the screen. You can select items to be displayed.

1 Click the [ ] button beside the [ ] button.
The [Preview properties display settings] window appears.

2 Specify display settings.

- To display recipe contents, select [Show recipe details] and checkmark items you want to display in the [Recipe display settings] tab sheet.
- To display shooting information, select [Show shooting info] and checkmark items you want to display in the [Shooting info display settings] tab sheet.
- After specifying settings, click the [Close] button.
3 Select an image and click the [ ] button.
   → The image and properties selected in step 2 are displayed in the screen.
   ● If the recipe contents of an image being edited are displayed in before/after comparison (two-screen/split-image display), edited items are displayed in red.

   All the property items may not be displayed depending on the combination of window, preview window, or the size of thumbnails.

   Checking an Image in Multi-Function Preview

   The preview window shows the coordinates of the mouse cursor and the work color space. By switching to multi-function preview, you can also check image details in the same way as the main window (multi-layout).

1 Select the [Tools] menu → [Preview screen display settings], and then [Multi-function preview] from the dialog that appears.
   ● After selecting, click the [Close] button.

2 Open the preview window (p.13).
   → A multi-function preview with various functions at the bottom of the screen is displayed.

   For how to use the displayed functions, see “Viewing an Image in the Main Window (Thumbnail Layout)” (p.10) and “Checking an Image Using the Preview Control Panel” (p.16 to p.20).
Checking an Image in Second Windows

Second windows are preview windows that you can open additionally for thumbnails and image previews. You can display up to 4 second windows for a single image to check the focus in all parts of the image, etc.

Select an image, and then select [Show second screen] from the menu that appears when you right-click with the mouse.

A second window is displayed.

- To display an additional second window, repeat the operation.
- You can change the size of second windows as desired.
- Click the displayed image to switch between actual pixel size (100% view) and fit-to-window view.
- When you magnify an image in the second window, the right-clicked position on the image will be the center for the magnification.
Opening and Closing Window Panels (Panes)

Panels (panes) at the top, bottom, left, and right of each window can be closed to suit the tasks being performed. You can use DPP in an optimal layout.

Click the [ ] for a panel to open or close.

Example: main window (thumbnail layout)

- When a panel is closed, you can point to [ ] with the mouse to temporarily open the panel.
Changing the Display Method and Order of Palettes

For any palette (tool palette, navigator palette, histogram palette, quick check palette, and camera control palette), you can change how the palette is displayed (docked/floating), or the display order of multiple docked palettes.

Changing the Display Method (Dock/Float) of Palettes

Right-click on the palette’s title bar (where its name is shown) and click [Dock/float] in the dialog that appears.

- A docked palette is then displayed floating, and a floating palette is then displayed docked.
- To revert to the original display method, repeat the same operation again.

Rearranging Palettes

When multiple palettes are docked, you can rearrange their order from top to bottom.

Right-click on the palette’s title bar (where its name is shown) and click [Move one up] or [Move one down] in the dialog that appears.

- The order of the palettes is changed.
Exiting DPP

In the main window, select the [File] menu ➤ [Exit].

In the main window, select the [File] menu ➤ [Exit].

In the main window, select the [File] menu ➤ [Exit].

In the main window, select the [File] menu ➤ [Exit].

In the main window, select the [File] menu ➤ [Exit].

In the main window, select the [File] menu ➤ [Exit].

A confirmation dialog box for saving the images appears when you try to exit DPP without saving the adjusted image. Click the [Yes to all] button to save the adjustment contents (recipe) to all the images adjusted.

A confirmation dialog box for saving the images appears when you try to exit DPP without saving the adjusted image. Click the [Yes to all] button to save the adjustment contents (recipe) to all the images adjusted.

A confirmation dialog box for saving the images appears when you try to exit DPP without saving the adjusted image. Click the [Yes to all] button to save the adjustment contents (recipe) to all the images adjusted.

A confirmation dialog box for saving the images appears when you try to exit DPP without saving the adjusted image. Click the [Yes to all] button to save the adjustment contents (recipe) to all the images adjusted.

A confirmation dialog box for saving the images appears when you try to exit DPP without saving the adjusted image. Click the [Yes to all] button to save the adjustment contents (recipe) to all the images adjusted.

A confirmation dialog box for saving the images appears when you try to exit DPP without saving the adjusted image. Click the [Yes to all] button to save the adjustment contents (recipe) to all the images adjusted.

A confirmation dialog box for saving the images appears when you try to exit DPP without saving the adjusted image. Click the [Yes to all] button to save the adjustment contents (recipe) to all the images adjusted.
Organizing and Sorting Images

Efficiently Checking/Sorting Images ................. 26
Sorting Images .................................................... 28
  Attaching Check Marks ..................................... 28
  Setting Ratings ............................................... 28
Sorting Images in the Main Window ................... 29
  Attaching Check Marks in the Main Window ........ 29
  Setting Ratings in the Main Window .................. 29
Arranging Images in the Main Window ............... 30
  Arranging by Type ......................................... 30
  Arranging Freely .......................................... 31
Displaying a RAW Image and JPEG Image as a Single Image............... 31
Checking Image Information ............................. 32
Organizing Images ............................................ 34
  Deleting an Unwanted Image ......................... 34
  Moving Images ............................................. 34
  Moving Images in Folders ............................... 35
Registering Frequent-Use Folders (Bookmark Registration) ............ 35
  Deleting Bookmarks ..................................... 35
Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window and efficiently check each image. You can sort images into groups.

1. **Select multiple images to check in the main window.**

2. **Display the quick check window.**
   - Click the [Quick check] button.
   
   ![Quick check window](image)

   ➔ The quick check window appears.

3. **Click the [ ] or [ ] button to switch between images to be checked.**
   - Quick check window

   ![Quick check window](image)

   - All the images displayed in the main window can be checked in the quick check window.
   - If you click the [ ] button, the first image is displayed, and if you click the [ ] button, the last image is displayed.
   - Click the [ ] button to return to the main window.
Click the area you want to enlarge.

The area you clicked is displayed at 100% (actual pixel size).
- To change the display position, drag on the image.
- If you click the [50%] button, you can display the image at 50%.
- Click again to revert to the full view.
- To exit, click the [ ] button.

In addition to 100% and 50%, you can display images at 12.5%, 25%, 200%, 300%, and 400%. Click the [ ] button beside the [50%] button on the screen, select a magnification from the menu that appears, and click the [close] button.

If you click the [50%] button (the selected magnification appears on the button), the image appears at the selected magnification. However, after the quick check window is closed, the image returns to its original 50% view.

When [AF Point] is checkmarked, you can display the AF points selected in the camera at the time of shooting. However, AF points are not displayed for images which have had their image size changed and then been converted and saved (p.80), which have had settings specified during RAW processing on the camera for distortion correction and chromatic aberration correction, which are composited, or which are created as HDR (High Dynamic Range) images.

Convenient functions of the quick check window

- To check only selected images
  You can use the quick check window to check only selected images by selecting the desired images from those displayed in the main window and then performing step 1.

- Switch between images using the keyboard
  You can also switch between images by pressing the <-> or <--> key.

- Switch between screens using the keyboard
  You can also switch between full screen display/normal screen display by pressing the <Alt> + <Enter> keys.

- Operate using the menu
  Each operation can also be performed with the menu which appears when you right-click with the mouse on an image.
**Sorting Images**
You can sort images by attaching check marks or setting ratings (indicated with [☆] marks) for each subject or theme.

**Attaching Check Marks**
Display the image you want to attach a check mark to, and then click any one of [1] to [5].

- The selected check mark appears in the upper left of the window.

**Setting Ratings**
Display the image you want to rate, and then click any one of the [ ].

- The rating is set and an icon corresponding to the selected [☆] appears in the upper left of the window.
  
  (Window shown with a rating of three [☆])

- To set [Reject], click the [Reject] button. Click the [Reject] button again to cancel.

- To cancel the rating, click the same [ ] as when the setting was made on the right of the window.

- The values of check marks attached to images in DPP version 4.0 or earlier are not maintained.
- You can also attach check marks from the menu that appears by right-clicking with the mouse on an image in the main window.

As the file structure of the image data is changed when a rating is set to an image, it may not be possible to check the image information in third-party software.
### Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks or setting ratings (indicated with [☆] marks) for each subject or theme.

#### Attaching Check Marks in the Main Window

Select the images you want to attach a check mark to, and then click any of [☆] to [☆☆].

- The selected check mark appears in the upper left of the image frame.

#### Setting Ratings in the Main Window

Select the images you want to rate, and then click any of the [☆].

- Click (changes to [☆☆] after clicking [☆])
  - The rating is set and an icon corresponding to the selected [☆☆] appears in the image frame.
- To cancel the rating, click the same [☆☆] as when the setting was made.
- Set [Reject] with the [Label] menu or the quick check window (p.26).
To select multiple images in the main window
Click on desired images while holding down the <Ctrl> key. To select multiple consecutive images, click on the first image, and then click on the last image while holding down the <Shift> key.

The [Label] menu can also be used to attach check marks and set ratings.
- You can display and change the rating settings set in DPP with other EOS software and on a supported camera.
  - EOS Utility version 2.9 or later:
    - Ratings set in DPP are displayed. However, [Reject] is not displayed and you cannot change rating settings.
  - On a supported camera:
    - Ratings set in DPP are displayed in the playback screen. You can also change rating settings. However, you cannot display or change settings for [Reject].
- Reversely, you can also display and change with DPP the rating settings set for images on a supported camera.

Arranging Images in the Main Window
You can arrange images in the order of the types of check marks you have attached to images, or in the order of date and time at which the images were shot. You can also freely arrange images by moving them individually.

Arranging by Type
Select the [Thumbnails] menu ➔ [Sort] ➔ desired item.

- The images are arranged in the order according to the selected item.

<table>
<thead>
<tr>
<th>Sort item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name: ascending order</td>
<td>Images are sorted by file name in alphanumeric order (0 to 9 → A to Z).</td>
</tr>
<tr>
<td>Extension: ascending order</td>
<td>Images are sorted in the following order: RAW images → JPEG images → TIFF images → MOV movies → MP4 movies.</td>
</tr>
<tr>
<td>Shooting Date/Time: ascending order</td>
<td>Images are sorted by shooting date and time from the earliest.</td>
</tr>
<tr>
<td>Check mark: ascending order</td>
<td>Images with check marks take priority and are sorted in number order.</td>
</tr>
<tr>
<td>Rating: ascending order</td>
<td>Sorted in order of fewest [★].</td>
</tr>
<tr>
<td>Camera Model Name: ascending order</td>
<td>Sorted in order of least digit used in the camera model name. (Ex.: EOS-1D X → EOS 6D)</td>
</tr>
<tr>
<td>Lens: ascending order</td>
<td>Sorted in order of shooting lens with shortest focal length.</td>
</tr>
<tr>
<td>ISO speed: ascending order</td>
<td>Sorted in order of lowest speed.</td>
</tr>
<tr>
<td>Shutter speed: ascending order</td>
<td>Sorted in order of fastest shutter speed.</td>
</tr>
<tr>
<td>Aperture value: ascending order</td>
<td>Sorted in order of lowest aperture value.</td>
</tr>
<tr>
<td>Focal length: ascending order</td>
<td>Sorted in order of shooting lens with shortest set focal length.</td>
</tr>
</tbody>
</table>

* Descending order sorts all items in the reverse of ascending order.
Arranging Freely
Drag and drop the image to the desired location.

→ The image moves to the desired location.
○ You can also select multiple images (p.30) and move them.
○ The order of rearranged images is temporarily registered as [Custom] in [Sort] of thumbnails control area and maintained until you exit DPP or select another folder in the folder area.
○ Select the [Thumbnails] menu ▶ [Sort] ▶ [File name] and [Ascending] to revert to the order before the images were rearranged.

Displaying a RAW Image and JPEG Image as a Single Image
You can display and handle a RAW image and JPEG image shot simultaneously as a single image. In particular, you can halve the number of images displayed in the main window and you can streamline the checking of a large number of images shot simultaneously.

Select the [Thumbnails] menu ▶ [Group RAW and JPG versions].
→ The main window display updates and the simultaneously shot RAW image and JPEG image are displayed as a single image with the [RUJ] mark (p.116).

RAW images with the extension “.CR2” can be displayed as a single image
Images that can be displayed as a single image are images shot with a camera that shoots RAW images with the extension “.CR2” and JPEG images simultaneously. Images that have been simultaneously shot with a camera that shoots RAW images with the extension “.CRW” or “.TIF” cannot be displayed as a single image.

When a single image is displayed
○ Image displayed
  The RAW image is displayed in all windows.
○ Edited image
  The content which has been adjusted with any of DPP’s functions (the tool palette etc.) will be applied to the RAW image only. However, if you have used the following functions, the adjustments will be applied to both the RAW image and the JPEG image.
  • Deleting an image (p.34)
  • Moving or copying an image (p.34)
  • Checkmarking (p.28, p.29)
  • Rating (p.28, p.29)
  • Rotating an image (p.10)

Maintaining the order of rearranged images
You can maintain the order of rearranged images even if you exit DPP or select another folder in the folder area.

○ Maintain order without changing image file names
  You can use the [General settings] tab sheet in [Preferences] to maintain the order of images without changing the image file names (p.109).

○ Maintain order and change image file names
  You can use the rename function to maintain the order of images and change the image file names all at once in the order they were rearranged (p.103).
Images added to the [Collection] window
When you add a RAW image and JPEG image displayed as a single image to the [Collection] window, the single image is marked with the [RCJ] mark. However, because the RAW and JPEG images are actually added individually, the number of images shown on the [Collection] tab sheet increases by 2.

Checking Image Information

1. Select the image for which you want to check the image information.
2. Select the [View] menu ▶ [Info].
   → The image information window appears.
3. Select a tab sheet and check information.

Image information window

[Exif Information] tab sheet

[XMP/IPTC Information] tab sheet

[Recipes] tab sheet

If you cancel selection of [Group RAW and JPG versions], the RAW image and JPEG image are displayed as separate images.
Shooting information is displayed in the [Exif Information] tab sheet, while IPTC* information appended to the image after shooting is displayed in the [XMP/IPTC Information] tab sheet. IPTC* information provides additional comments on images, such as captions, credits and the shooting location. The information is sorted into 5 different categories and can be viewed by selecting [Description], [IPTC Contact], [IPTC Image], [IPTC Content] or [IPTC Status] from the list box in the [XMP/IPTC Information] tab sheet.

* International Press Telecommunications Council (IPTC)

The contents of the [Exif Information] tab sheet will vary depending on the camera model.

Recipe contents applied to an image are displayed in the [Recipes] tab sheet.

### Convenient uses in the main window

#### Switching displays

If a different image is selected in the main window when the image information window is displayed, the image information for that image will be displayed.

#### Difference with the thumbnail with shooting information

Detailed shooting information for each image is displayed in the image information window. However, if you want to only check the main shooting information, you can check it for each image in [Thumbnails] menu ➤ [With shooting info] (p.10).
Organizing Images

This section explains how to delete unwanted images, move or copy images, etc., to organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

1. Select an unwanted image in the main window.
2. Select the [File] menu → [Move to Recycle Bin].

The image is moved to the [Recycle Bin] and is deleted from DPP.

The images are deleted completely from your computer when the [Empty Recycle Bin] operation is performed on the [Recycle Bin] on the desktop.

Moving Images

You can move or copy images to a separate folder and sort by shooting date or themes.

Drag the image to be moved or copied.

- To move: Drag the image and release when the image is in the destination folder.
- To copy: Drag the image while holding down the <Ctrl> key and release when the image is in the destination folder.

The images are moved or copied to the destination folder.
Moving Images in Folders
You can move or copy folders that contain images, and sort the images by folders.

Drag the folder to be moved or copied.
- To move: Drag the folder and release when the folder is in the destination folder.
- To copy: Drag the folder while holding down the <Ctrl> key and release when the folder is in the destination folder.

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)
You can register frequently used folders in bookmarks. Registered folders are displayed in the [Bookmark] tab sheet in the main window.

1 Select the folder for which a bookmark is to be registered.

2 Select the [File] menu ➔ [Bookmark].
   ➔ The folder selected in step 1 is registered in the [Bookmark] tab sheet in the main window.

Deleting Bookmarks
You can delete a folder registered in [Bookmark].

Select the [File] menu ➔ [Remove bookmark].
=> The selected folder is deleted from bookmarks.
4 Editing Images

RAW Images ................................................................. 38
  RAW Images ........................................................... 38
  RAW Development .................................................... 38
  When RAW Development is to be Done .................... 38
  Advantages of a RAW Image .................................... 38
Editing JPEG and TIFF Images ................................. 39
Tool Palettes .................................................................. 40
  Editing with the Basic Adjustment Tool
Palette ........................................................................ 41
    Adjusting Brightness ............................................. 41
    Changing the Picture Style ...................................... 42
      Advanced Using a Picture Style File ......................... 43
    Adjusting Color Tone by Changing White Balance .... 43
    Adjusting Color Tone Using Click White Balance ...... 44
      Advanced Adjusting White Balance with Color       45
        Temperature ....................................................... 45
      Advanced Tuning White Balance .............................. 45
    Adjusting Contrast ................................................ 46
      Advanced Adjusting Brightness of Shadows/          46
        Highlights .......................................................... 46
    Changing Color Tone and Color Saturation ............... 47
      Adjusting Monochrome ......................................... 47
      Advanced Adjusting Dynamic Range ....................... 48
      Advanced Adjusting Gradation and Luminance        49
        Automatically .................................................. 49
    Using the Auto Lighting Optimizer ......................... 50
    Adjusting Image Sharpness ..................................... 51
      Detailed Setting of Image Sharpness ....................... 52

JPEG/TIFF Editing with the Tone Adjustment Tool
Palette ........................................................................ 53
  Adjusting Brightness and Contrast ......................... 53
  Adjusting Color Tone Using Click White Balance ....... 54
      Advanced Adjusting Tone Curve ............................... 55
      Example of a Tone Curve Operation ....................... 56
      Advanced Adjusting Dynamic Range ....................... 57
      Using the Auto Lighting Optimizer ....................... 57

JPEG/TIFF Editing with the Color Adjustment Tool
Palette ........................................................................ 58
      Advanced Editing with the Color Adjustment Tool
Palette ....................................................................... 58
        Adjusting a specific color gamut ......................... 58
        Adjusting hue and saturation for an entire image .... 59

JPEG/TIFF Editing with the Detailed Adjustment Tool
Palette ......................................................................... 60
  Reducing Noise ......................................................... 60
  Adjusting Image Sharpness ....................................... 61

JPEG/TIFF Editing with the Trimming/ Angle Adjustment
Tool Palette ............................................................... 62
Editing with the Lens Correction Tool Palette .......... 65
  Correcting Lens Aberration ....................................... 65
  Compatible Lenses .................................................... 65
Making Corrections ....................................................... 67
  Effects of Distortion Correction for Fisheye
    Lenses ..................................................................... 68
Shooting Distance Information Slider ........................................ 69
Correcting Multiple Images at a Time ..................................... 70
Digital Lens Optimizer ........................................................... 70
Compatible Lenses ................................................................. 70
Using the Digital Lens Optimizer ............................................ 71
Adjusting Image Sharpness ..................................................... 73

Editing with the Dust Delete/Copy Stamp Tool Palette ....................... 74
Performing Automatic Dust Erasure Processing ........................ 74
Automatic Dust Erasure Processing in the Main Window ............. 75
Manually Erasing Dust (Repair Function) .................................. 76
Erasing Unwanted Parts of an Image (Copy Stamp Function) ....... 78

Setting Work Color Space .......................................................... 79

Saving Editing Results ............................................................. 80
Saving Editing Contents to an Image ......................................... 80
Saving as a separate image ...................................................... 80

Re-Editing an Image ................................................................. 82

Utilizing Adjustment Contents (Recipe) .................................... 83
Copying a Recipe and Applying to Another Image ....................... 84
Saving a Recipe as a File .......................................................... 84
Loading and Applying Recipes ................................................ 85

Adjusting by Comparing Multiple Images ..................................... 86

Editing Efficiently ................................................................. 87

Editing in the Edit Image Window ........................................... 87
Changing the Thumbnail Display Position to Horizontal ................. 88
Gathering and Editing Images in the Collection Window ............... 89

Advanced Transferring a RAW Image to Photoshop ................. 91
Advanced Customizing the Main Window Toolbar .......... 92

* Sections with and in "4 Editing Images" support not only RAW image editing but also JPEG/TIFF image editing.

: All the functions explained in the section support JPEG/TIFF image editing.
: Part of the functions explained in the section support JPEG/TIFF image editing.
RAW Images

A RAW image is image data that has recorded output data of imaging sensor. As image processing is not performed inside the camera when a photo is taken and the photo has been recorded in the special form of “RAW image data + Image processing conditions information at the time of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

RAW Development

If described in terms of film, the concept of a RAW image is a shot image not yet developed (latent image). With film, the image appears for the first time when it is developed. In the same way, for RAW images too, you cannot view them as images on your computer unless you perform subsequent image signal processing. Therefore, even though it is digital, this processing is called “development”.

When RAW Development is to be Done

DPP automatically carries out this “development” processing when RAW images are displayed in DPP. As a result, RAW images displayed in DPP are images whose development processing has been completed.

With DPP, you can view, edit and print RAW images without being particularly conscious of the development processing.

Advantages of a RAW Image

RAW images are recorded in the format “RAW image data + Image processing conditions information at the time of shooting”. When you open a RAW image in DPP, the image is automatically developed and you can view the image as an image to which image processing conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened (it undergoes automatic development processing each time), only the image processing conditions (development conditions) change and the “original image data itself” remains unaffected. Therefore, it is the perfect data for users who want to get creative with the images after shooting, as you do not have to worry about image deterioration.

In DPP, the “Image processing conditions information” that can be adjusted is called a “Recipe” (p.83).

Contents adjusted using the tool palettes can be handled individually as a recipe file (extension “.dr4”) (p.83, p.84).

In DPP, all the adjustments (image processing conditions information) made with the tool palettes can be saved in the image as data called a “recipe” (p.84), or can be saved, downloaded and applied to other images as a separate recipe file (extension “.dr4”, p.85). However, a recipe file with saved RAW image adjustments cannot be applied to JPEG or TIFF images.
Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as RAW images using the tool palettes below.

- Tone Adjustment tool palette
- Color Adjustment tool palette
- Detailed Adjustment tool palette
- Trimming/Angle Adjustment tool palette
- Dust Delete/Copy Stamp tool palette
- Settings tool palette

Because adjustments made with these tool palettes (the recipe) only change the image processing conditions, the “original image data itself” remains unaffected. Consequently, there is none of the image deterioration that normally accompanies editing and you can readjust your image any number of times.

Editing JPEG and TIFF Images

In DPP, all the adjustments (image processing conditions information) made with the tool palettes can be saved in the image as data called a “recipe” (p.84), or can be saved, downloaded and applied to other images as a separate recipe file (extension “.dr4”, p.85). However, recipe data with saved JPEG or TIFF image adjustments cannot be applied to RAW images.
Tool Palettes

With DPP, you can adjust images with the tool palettes by switching between various tool palette windows according to your editing requirements. Since adjustments made with the tool palettes only change the image processing conditions, the “original image data itself” remains unaffected. As there is no image deterioration that normally accompanies editing, you can readjust your image any number of times. The various functions of the tool palettes are explained in more detail under the respective topics.

- **Basic Adjustment tool palette**
  Makes basic adjustments to a RAW image (p.41).

- **Tone Adjustment tool palette**
  Adjusts the tone curve and applies the Auto Lighting Optimizer (p.53).

- **Color Adjustment tool palette**
  Adjusts the hue, saturation and luminance of a specific color space. The hue and saturation for an entire image can also be adjusted (p.58).

- **Detailed Adjustment tool palette**
  Reduces noise and adjusts the image sharpness (p.60).

- **Trimming/Angle Adjustment tool palette**
  Crops an image and adjusts the image angle (p.62).

- **Lens Correction tool palette**
  Corrects lens aberration in the image (p.65) and applies the Digital Lens Optimizer (p.71).

- **Dust Delete/Copy Stamp tool palette**
  Erases dust from an image and corrects image by copying sections of the image (p.74).

- **Settings tool palette**
  Configures the work color space (p.79).

**Using the different tool palettes**

We recommend that you use the Basic Adjustment tool palette to make adjustments to RAW images. However, if you find that the Basic Adjustment tool palette does not offer a sufficient range of adjustments, or if you want to use specific functions that are only available in the Tone Adjustment tool palette (p.53), completing initial adjustments with the Basic Adjustment tool palette and then using the Tone Adjustment tool palette to make just the minimum of adjustments needed is recommended.

For noise reduction (p.60) and lens aberration correction (p.67), you should first complete necessary adjustments in the Basic Adjustment and Tone Adjustment tool palettes, and then adjust with the Detailed Adjustment tool palette (p.60) and Lens Correction tool palette (p.65).
Editing with the Basic Adjustment Tool Palette

The Basic Adjustment tool palette makes basic adjustments to RAW images. With this tool palette, you can adjust the image brightness, set Picture Style, adjust the white balance, adjust the contrast, adjust the color tone and saturation, adjust the dynamic range, apply the Auto Lighting Optimizer and adjust the image sharpness.

Note that the only adjustments you can make to JPEG/TIFF images are applying the Auto Lighting Optimizer and adjusting the image sharpness.

1 Select an image in the main window, etc.

2 Display the Basic Adjustment tool palette.

![Tool palette]

- Brightness adjustment
  - Move the slider to the right to make the image brighter and to the left to make the image darker.
  - The adjustment range is –3.0 to +3.0 (in 0.01-stop increments when entering a value).

   Reverts the image to the original settings

   Enter a numerical value

   Drag the slider left or right

   The adjustment range is –3.0 to +3.0 (in 0.01-stop increments when entering a value).
Changing the Picture Style

If the image looks different from what you visualized at the time of shooting, you can get it closer to what you expected by changing the Picture Style. Even if you have saved the image (p.47) with [Monochrome] (p.80) selected, you can still change to another Picture Style at any point by simply selecting a Picture Style other than [Monochrome].

![Image of Picture Style settings]

- You can retain the [Color tone], [Color saturation], [Contrast], [Unsharp mask] and [Sharpness] settings, even if you change the Picture Style.
- You cannot select [Auto] with multiple-exposure RAW images created on the camera.

### Picture Style

<table>
<thead>
<tr>
<th>Picture Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>The image looks vivid. Generally, this setting is suitable for most images.</td>
</tr>
<tr>
<td>Auto</td>
<td>The color tone will be adjusted to suit the scene. The colors will look vivid. Especially the colors of blue skies, greenery, and sunsets will be vivid in a shot of nature, outdoor, or sunset scenes.</td>
</tr>
<tr>
<td>Portrait</td>
<td>For nice skin tones. Effective for close-ups of women and children. By changing the [Color tone], you can adjust the skin tone (p.47).</td>
</tr>
<tr>
<td>Landscape</td>
<td>For vivid blues and greens. Effective for making images of landscapes impressive.</td>
</tr>
<tr>
<td>Neutral</td>
<td>For natural colors and subdued images. Effective for base images which are to undergo adjustment.</td>
</tr>
<tr>
<td>Faithful</td>
<td>When the subject is photographed under a color temperature of 5200K, the color is adjusted colorimetrically to match the subject’s color. Effective for base images which are to undergo adjustment.</td>
</tr>
<tr>
<td>Monochrome</td>
<td>For black and white images. You can also adjust with [Filter effect] or [Toning effect] (p.47).</td>
</tr>
</tbody>
</table>

* (Picture Style file registered in the camera) Displayed when selecting an image shot with the Picture Style file registered in the camera. In the list, the name of the Picture Style file is displayed in ( ).

[Picture Style file applied in DPP] The name of the Picture Style file applied in DPP is displayed in [ ].
Using a Picture Style File

A Picture Style file is a Picture Style extension file. With DPP, you can apply to RAW images Picture Style files that you have downloaded from Canon Web site effective for various scenes or Picture Style files created with “Picture Style Editor”. When using a Picture Style file, save it to your computer beforehand.

1. Click the [Browse] button in the panel.

   ![Picture Style panel]

   ➔ The [Open] dialog box appears.

2. Select a Picture Style file saved on your computer, and click the [Open] button.

   ➔ The Picture Style file you selected is applied to an image.
   • To apply a different Picture Style file, follow the procedure from step 2 again.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural, change the white balance to make it appear natural. You can make the color tone natural by setting the light source to match the scene at the time of shooting an image of, for example, pale-colored flowers.

1. Click the [Browse] button in the panel.

   ![Picture Style panel]

   ➔ The [Open] dialog box appears.

2. Select a Picture Style file saved on your computer, and click the [Open] button.

   ➔ The Picture Style file you selected is applied to an image.

   • To apply a different Picture Style file, follow the procedure from step 2 again.

   ![Picture Style color tone adjustment]

   Reverts the image to the original settings

The color tone does not become more natural even when the white balance is changed

If the color tone of the image does not appear natural after changing the white balance, adjust the white balance using click white balance (p.44).

Tune with color tone

To make further fine adjustments to color tone after adjusting the white balance, you can use [Color tone] (p.47) for tuning towards your expectations.

- You cannot register the adjustment results as personal white balance (p.98) when you have selected [ ] from the list box.
- You cannot change or adjust white balance with multiple-exposure RAW images created on the camera.

Refer to your camera’s Instruction Manual for details on each white balance setting.

The Picture Style files that you can apply to the camera are files with the “.PF2” or “.PF3” extension only.
Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the standard for white to make the image appear natural. Using click white balance is effective when using it in parts of an image where white color tone has changed under the influence of a light source.

1. Click on a point that is to be the standard for white.

2. The coordinates of the cursor position and the RGB values (8-bit conversion)

Reverts the image to the original settings

The color of the image is adjusted with the point you selected as the standard for white.

- If you click on another point in the image, the white balance is adjusted again.
- To finish click white balance, right-click with the mouse or click the button again.

When there are no white areas in your image

When there are no white areas in your image, you can adjust the white balance by clicking on a grey point of the image in step 2. This has the same adjustment result as selecting a white area.

When there are no white areas in your image, you cannot change or adjust white balance with multiple-exposure RAW images created on the camera.
Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color temperature.

2. Set the color temperature.

Tune the white balance by dragging the point in the adjustment screen in the [Tuning] panel.

- B stands for blue, A for amber, M for magenta and G for green. The color is adjusted towards the color to which the point moves.
- You can also fine-tune your adjustment by using the sliders or entering the adjustment values.

The adjustable range is 0 to ±10. (in 0.1-stop increments when entering a value).

The adjustment range is 2000 to 10000K (in 10K increments).
**Adjusting Contrast**
Modulation and degree of contrast can be adjusted. Move the slider to the right to make contrast stronger and to the left to make contrast weaker.

---

**Advanced**
**Adjusting Brightness of Shadows/Highlights**
You can adjust the brightness of shadows and highlights in an image. By adjusting only shadows or highlights in an image, you can reduce the effects of clipping in shadows and highlights.

---

If you make a major adjustment to the highlights or shadows in an image, the image may look unnatural. In such a case, reduce the degree of adjustment.
Changing Color Tone and Color Saturation

Tone and overall color saturation can be adjusted. If Picture Style (p.42) is set to [Monochrome], [Color tone] and [Color saturation] switch to [Filter effect] and [Toning effect] (this page).

- **Color tone:** Move the slider to the right to make tones more yellowish, and to the left to make tones more reddish.
- **Color saturation:** Adjusts the overall color intensity for the image. Move the slider to the right for more intense colors, and to the left for less intense colors.

2. Reverts the image to the original settings
3. Displays the values of the settings

The adjustment range is –4 to +4.
Filter effect: Creates a monochrome photograph where the white of clouds and the green of trees are emphasized.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Example of effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>General monochrome image without filter effect.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Blue sky is reproduced more naturally and white clouds emerge clearly.</td>
</tr>
<tr>
<td>Orange</td>
<td>Blue sky becomes somewhat darker. The brightness of the setting sun increases further.</td>
</tr>
<tr>
<td>Red</td>
<td>Blue sky becomes quite dark. Autumn leaves become clear and bright.</td>
</tr>
<tr>
<td>Green</td>
<td>Human skin tones and lips become softer. The green leaves of trees become clear and bright.</td>
</tr>
</tbody>
</table>

Toning effect: Creates a monochrome photograph to which a single color has been added. You can choose from [None], [Sepia], [Blue], [Purple] and [Green].

To emphasize the filter effect, set the [Contrast] slider to the right.

Increasing the [Contrast] to emphasize the filter effect.

Dynamic range (width of gradation expression) from dark points to bright points in an image can be adjusted.

- The horizontal axis shows the input level and the vertical axis shows the output level.
- Checkmark the [Move with mid-point] checkbox to link the mid-point to your adjustments to the input white points and input black points.

Adjusting Dynamic Range

Move to the left or right
Input black points

Move downwards
Output white points

Move to the left or right
Input white points

Move to the left or right
Mid (medium tone) point

Move upwards
Output black points

You can also adjust the dynamic range by entering values.
[Linear] - A function for advanced adjustment

Use [Linear] when you adjust images using image editing software that has advanced editing functions. Note that when [Linear] is checkmarked, the image becomes dim.

[Contrast], [Highlight], [Shadow], and [Auto Lighting Optimizer] (p.50) will not function when [Linear] is checkmarked.

Adjusting Gradation and Luminance Automatically

In order to give the image desirable gradations and luminance, automatic adjustments are applied for an appropriate dynamic range.

Click the [Auto] button.

In order to give the image desirable gradations and luminance, the dynamic range is automatically adjusted.

- White points, midpoint, and black points in the [Gamma adjustment] panel as well as [Highlight] and [Shadow] in the [Advanced] panel are adjusted automatically.
- Settings that are reset and those that are not with this adjustment are as follows.
  - Settings that are reset
    - Auto Lighting Optimizer
    - [Contrast] in the [Advanced] panel
  - Settings that are not reset
    - Brightness adjustment
    - White balance adjustment
    - Linear*
  - *White points and black points are automatically adjusted.

An image may look unnatural after automatic adjustment. In such a case, reduce the degree of shadow and highlight adjustment.
Using the Auto Lighting Optimizer

If the shooting result is dark or the contrast is low, you can use the Auto Lighting Optimizer function to auto-correct the brightness and contrast, and obtain a more favorable image.

You can also change the setting of the image shot with the camera’s Auto Lighting Optimizer function.

This function also can be used for JPEG/TIFF images in addition to RAW images.

* ALO stands for Auto Lighting Optimizer.


- For the image shot with the camera’s Auto Lighting Optimizer function, the checkbox is already checked.

2. Change the setting according to your preferences.

- Auto correction is applied to the image to match the setting.
- For the image shot with the camera’s Auto Lighting Optimizer function, the setting at the time of shooting is applied as the default value.
- To cancel the Auto Lighting Optimizer, remove the check mark from the checkbox.

- When [Highlight tone priority] is set to [Enable] on the camera, the Auto Lighting Optimizer cannot be used for RAW images.
- You cannot use the Auto Lighting Optimizer with multiple-exposure RAW images created on the camera.
- When you apply Auto Lighting Optimizer to the RAW and JPEG images shot simultaneously, the correction results of the two images may differ.
Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer. Adjustment can be made by selecting from two modes, [Sharpness] and [Unsharp mask].

[Sharpness]: Controls the sharpness of an image by adjusting the level of emphasis for the outline of the image. The further to the right the [Sharpness] slider is moved (the larger the setting value), the more the edges are emphasized for a sharper image.

[Unsharp mask]: Adjusts the image's sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the image. The further to the right the slider is moved (the larger the setting value), the more the image's edges are emphasized for a sharper image.

[Fineness]: Shows the fineness of the emphasized outline. The further to the left the slider is moved (the smaller the setting), the more fine detail can be emphasized.

[Threshold]: Sets "how much contrast difference there should be compared to surroundings before emphasizing edges".

Select [Sharpness] from the list box and adjust the setting.

The adjustment range is 0 to 10.
Detailed Setting of Image Sharpness

Select [Unsharp mask] from the list box and adjust the setting.

Adjust image sharpness with the window view set to [400%], [200%] or [100%]. If the view is set to [Fit to window] (full view), you may not be able to correctly check the adjustment results.
Editing with the Tone Adjustment Tool Palette

With the Tone Adjustment tool palette, you can adjust images with the same functions as general image editing software.

1. Select an image in the main window, etc.
2. Display the Tone Adjustment tool palette.

Adjusting Brightness and Contrast

The brightness and contrast of an image can be adjusted. Since the adjustment range is broader than the same functions in the Basic Adjustment tool palette, the image color may be saturated, or the image quality may deteriorate if you adjust too much. Be especially careful when adjusting.

- Drag the sliders left or right
- Enter a setting (in 0.1-stop increments)
- Reverts the image to the original settings
• **Brightness**: Move the slider to the right to make an image brighter and to the left to make an image darker.

• **Contrast**: Used to adjust modulation and degree of contrast of color. Move the slider to the right to make contrast of an image stronger and to the left to make contrast weaker.

---

### Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the standard for white to make the image appear natural. Using click white balance is effective when using it in parts of an image where white color tone has changed under the influence of a light source.

1. **Click the [] button.**

The adjustment range is –100 to +100 (in 0.1-stop increments when entering a value).
Click on a point that is to be the standard for white.

The coordinates of the cursor position and the RGB values (8-bit conversion)

→ The color of the image is adjusted with the point you selected as the standard for white.
• If you click on another point in the image, the white balance is adjusted again.
• To finish click white balance, right-click with the mouse or click the [ ] button again.

**When there are no white areas in your image**

When there are no white areas in your image, you can adjust the white balance by clicking on a grey point of the image in step 2. This has the same adjustment result as selecting a white area.

The histogram display changes according to adjustment. You can also display the histogram before making any adjustments.

**Advanced Adjusting Tone Curve**

You can adjust the brightness, contrast and color of a specific area by changing the tone curve (p.117).

1 Select the tone curve mode and interpolation method.
Make adjustments.

The horizontal axis shows the input level and the vertical axis shows the output level.

The maximum number of [ ] is 8.

To delete a [ ], either press the <Del> key or double-click on the [ ].

For example, if you want to make medium tones brighter, you can set the coordinates of the curve to make the output level higher than the input level for medium tones. Conversely, if you want to make medium tones darker, you can set the coordinates of the curve to make the output level lower than the input level for medium tones.

You can display pre- and post-adjustment histograms to compare the differences.

RGB: Adjusts RGB in a batch
R, G, B: Adjusts each channel

Example of a Tone Curve Operation

- Makes medium tones brighter
- Makes medium tones darker
- Makes tones sharper
- Makes tones softer
**Advanced**

**Adjusting Dynamic Range**

Dynamic range (width of gradation expression) from dark points to bright points in an image can be adjusted.

- The setting range of black points is 0 to 247 (in 1-stop increments when entering a value).
- The setting range of white points is 8 to 255 (in 1-stop increments when entering a value).
- You can display pre- and post-editing histograms (p.56).

---

**Using the Auto Lighting Optimizer**

For information on using the Auto Lighting Optimizer, see “Using the Auto Lighting Optimizer” (p.50) in “Editing with the Basic Adjustment Tool Palette”.

- The horizontal axis shows the input level and the vertical axis shows the output level.
**Editing with the Color Adjustment Tool Palette**

With the Color Adjustment tool palette, you can adjust the hue, saturation and luminance in a specific color gamut for 8 color gamuts (red, orange, yellow, green, aqua, blue, purple and magenta). You can also adjust the hue and saturation for the entire image.

1. Select an image in the main window, etc.
2. Display the Color Adjustment tool palette.

### Adjusting a specific color gamut

Use the sliders to make adjustments. You can also make adjustments by directly entering a numeric value.

- **H:** Adjusts the hue.
- **S:** Adjusts the saturation.
- **L:** Adjusts the luminosity.

The adjustment ranges are as follows:

- **H:** –20 to +20
- **S:** –10 to +10
- **L:** –10 to +10
Adjusting hue and saturation for an entire image

Use the sliders to make adjustments. You can also make adjustments by directly entering a numeric value.

- **Hue:** Move the slider to the right to make color tones more yellowish, and to the left to make color tones more reddish.
- **Saturation:** Adjusts the overall color intensity for the image. Move the slider to the right for more intense colors, and to the left for less intense colors.

![Color adjustment interface]

- Revert all adjustments to the original settings
- Enter the values to set
- Drag the sliders left or right

The adjustment range for hue is –30 to +30; and for saturation is 0 to 200.
Editing with the Detailed Adjustment Tool Palette

You can use the Detailed Adjustment tool palette to reduce the noise that occurs in images shot at night or at high ISO settings. This tool palette can also be used in conjunction with the sharpness adjustment functions. Note that you can use the functions in this tool palette with JPEG and TIFF images as well as RAW images.

1 Select an image in the main window, etc.

2 Display the Detailed Adjustment tool palette.

You can use the Detailed Adjustment tool palette to reduce the noise that occurs in images shot at night or with a high ISO speed.

* NR stands for Noise Reduction.

Adjust an image.

- You can set a noise reduction level from within a range of 0 to 20. The larger the setting, the larger the noise reduction effect.
- The noise reduction effect can also be checked in the check window.
Setting the same noise reduction level for several images

You can set the same noise reduction level for several images by first selecting multiple images in the main window, and then adjusting the noise reduction level using the [Reduce luminance noise] and [Reduce chrominance noise] sliders.

- If [Reduce luminance noise] is set, resolution may be reduced along with reduction of noise.
- If [Reduce chrominance noise] is set, color bleeding may occur along with reduction of noise.

Adjusting Image Sharpness

You can also use this palette to adjust the image sharpness. For information on making adjustments, see “Adjusting Image Sharpness” in “Editing with the Basic Adjustment Tool Palette” (p.51).
Editing with the Trimming/Angle Adjustment Tool Palette

You can crop only the part of an image you need, or change the composition of an image where an image shot horizontally becomes vertical. You can also adjust the angle of an image before cropping.

1. **Select the image to be cropped.**

2. **Display the Trimming/Angle Adjustment tool palette.**
   - You cannot make adjustments with the Trimming/Angle Adjustment tool palette in a window that only shows thumbnails.

3. **Adjust the angle of the image as needed.**

   **Trimming/angle adjustment window**
   
   Largest possible trimming range
   
   Drag (0.01-degree increments; adjustment range: –45 to +45 degrees)
   
   Use the mouse (click ▲/▼) to adjust the angle or directly enter the adjustment angle (0.01-degree increments; adjustable range: –45 to +45 degrees)

4. **Select a ratio and drag the trimming range.**

   - The trimming range can be moved by dragging.
   - You can enlarge or reduce the size of the trimming range by dragging the four corners of the trimming range.

   - If you click [Center on Screen], you can display the trimming range in the center of the window.
   - When correcting lens aberrations, it is recommended to perform lens aberration correction before adjusting the angle of the image.
   - If you have only adjusted the angle of the image, the image will be cropped at the largest possible trimming range.

When aspect ratio information is attached to an image, the displayed trimming range is based on the aspect ratio information.
List of aspect ratios (width : height)

<table>
<thead>
<tr>
<th>Free</th>
<th>11</th>
<th>16:9</th>
<th>5:4</th>
<th>3:4</th>
<th>2:3</th>
<th>3:2</th>
<th>Custom</th>
</tr>
</thead>
</table>

[Free]: You can crop an image to any size, regardless of the selectable ratio.

[Custom]: You can crop an image at the specified ratio.

Return to the main window.

- The trimming range frame is displayed in the cropped image. (p.116)
- When the cropped image is displayed in a preview window or the edit image window, it is displayed in its cropped form.

### Cropped images

#### The trimmed range can be reverted to its original condition at any time

A cropped image is displayed or printed as a cropped image. However, since the image is not actually cropped, you can always revert to the original image by clicking the [ ] button in the trimming/angle adjustment window or performing the “Re-Editing an Image” procedure (p.82).

#### Display of the cropped image in each window

- **Main window**: The frame showing the trimming range is displayed on the image (p.116).
- **Preview window**: The image is displayed in its cropped condition.
- **Edit image window**: The thumbnail image is the same as the main window display, and the enlarged image is the same as the preview window display.

#### Printing a cropped image

You can print as a cropped image by printing it in DPP.

#### The image becomes a cropped image when converted and saved

The cropped RAW image actually becomes a cropped image when converted to a JPEG or TIFF image and saved (p.80).

#### Images that have aspect ratio set will be displayed as cropped images

When aspect ratio information is attached to a RAW image, the image will be displayed in the set trimming range based on the aspect ratio information. Since the image is not actually cropped, you can change the trimming range or revert to its condition before cropping. However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect ratio set with the EOS 5D Mark III or EOS 6D, its trimming range cannot be changed or the image cannot be reverted to its condition before cropping, since the image is actually cropped and saved in the set trimming ratio.

When reverting to the trimming range that is based on the aspect ratio information at the time of shooting, click the [ ] button. Also, if you want to cancel all the trimming range, click the [Clear] button.
• When shooting with EOS 5D Mark III and [Add cropping information] is set in Custom Functions, aspect ratio information is only set and the image is not actually cropped, even for JPEG images.

**Operate using the menu**
Each operation can also be performed with the menu which appears when you right-click with the mouse on the image.

**Apply the trimmed range to another image**
You can apply the trimmed range to another image by clicking the [Copy] button to copy the trimmed range, displaying another image and then clicking the [Paste] button.
To batch apply a copied trimming range to multiple images, select the cropped image in the main window together with the images to which you want to apply the trimming range and then display the Trimming/Angle Adjustment tool palette. With the cropped image displayed, click the [Copy] button and then click the [Paste] button. This will apply the trimming range to all the images selected when the trimming/angle adjustment window is displayed.
To select multiple images in the main window, click the images while holding down the <Ctrl> key. To select multiple consecutive images, click on the first image, and then click on the last image while holding down the <Shift> key.

⚠️ For images shot with ISO speed range expansion set, noticeable noise may make it difficult to view the image in detail in the trimming/angle adjustment window.
Editing with the Lens Correction Tool Palette

With the Lens Correction tool palette, you can use the lens aberration correction functions and the Digital Lens Optimizer to correct lens aberration in your images and to improve their resolution. This tool palette can also be used in conjunction with the sharpness adjustment functions. Note that the lens aberration correction functions and the Digital Lens Optimizer can only be used with RAW images.

1. Select an image in the main window, etc.

2. Display the Lens Correction tool palette.

Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination, distortions in the subject, and color blur which occur by the physical characteristics of the lens or slightly remaining aberration. Note that you can only correct aberration in RAW images which have been shot with the following "Compatible Lenses". JPEG or TIFF images cannot be corrected.

Compatible Lenses

<table>
<thead>
<tr>
<th>Fisheye, ultra wide, and wide angle lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 14mm f/2.8L USM</td>
</tr>
<tr>
<td>EF 8-15mm f/4L USM Fisheye</td>
</tr>
<tr>
<td>EF 15mm f/2.8 Fisheye</td>
</tr>
<tr>
<td>EF 20mm f/2.8 USM</td>
</tr>
<tr>
<td>EF 24mm f/1.4L II USM</td>
</tr>
<tr>
<td>EF 24mm f/2.8 IS USM</td>
</tr>
<tr>
<td>EF 28mm f/1.8 IS USM</td>
</tr>
<tr>
<td>EF 35mm f/1.4L USM</td>
</tr>
<tr>
<td>EF 35mm f/2 IS USM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Standard and medium telephoto lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 40mm f/2.8 STM</td>
</tr>
<tr>
<td>EF 50mm f/1.4 USM</td>
</tr>
<tr>
<td>EF 50mm f/1.8 II</td>
</tr>
<tr>
<td>EF 85mm f/1.2L II USM</td>
</tr>
<tr>
<td>EF 100mm f/2 USM</td>
</tr>
</tbody>
</table>
## Telephoto lenses

<table>
<thead>
<tr>
<th>Lens Configuration</th>
<th>Lens Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 135mm f/2L USM</td>
<td>EF 135mm f/2.8</td>
</tr>
<tr>
<td>(with Softfocus mechanism)</td>
<td></td>
</tr>
<tr>
<td>EF 200mm f/2L IS USM</td>
<td>EF 200mm f/2.8L USM</td>
</tr>
<tr>
<td>EF 200mm f/2.8L II USM</td>
<td>EF 300mm f/2.8L IS II USM</td>
</tr>
<tr>
<td>EF 300mm f/2.8L IS USM</td>
<td>EF 300mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 400mm f/2.8L IS USM</td>
<td>EF 400mm f/2.8L II USM</td>
</tr>
<tr>
<td>EF 400mm f/4 DO IS USM</td>
<td>EF 400mm f/5.6L USM</td>
</tr>
<tr>
<td>EF 500mm f/4L IS USM</td>
<td>EF 500mm f/4L IS II USM</td>
</tr>
<tr>
<td>EF 600mm f/4L IS USM</td>
<td>EF 600mm f/4L IS II USM</td>
</tr>
<tr>
<td>EF 800mm f/5.6L IS USM</td>
<td>__________</td>
</tr>
</tbody>
</table>

## Zoom lenses

<table>
<thead>
<tr>
<th>Lens Configuration</th>
<th>Lens Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 16-35mm f/2.8L USM</td>
<td>EF 16-35mm f/2.8L II USM</td>
</tr>
<tr>
<td>EF 17-35mm f/2.8L USM</td>
<td>EF 17-40mm f/4L USM</td>
</tr>
<tr>
<td>EF 20-35mm f/3.5-4.5 USM</td>
<td>EF 24-70mm f/2.8L USM</td>
</tr>
<tr>
<td>EF 24-70mm f/2.8L II USM</td>
<td>EF 24-70mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 24-85mm f/3.5-4.5 USM</td>
<td>EF 24-105mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 28-70mm f/2.8L USM</td>
<td>EF 28-90mm f/4-5.6 USM</td>
</tr>
<tr>
<td>EF 28-90mm f/4-5.6 II USM</td>
<td>EF 28-90mm f/4-5.6</td>
</tr>
<tr>
<td>EF 28-90mm f/4-5.6 II</td>
<td>EF 28-90mm f/4-5.6 III</td>
</tr>
<tr>
<td>EF 28-105mm f/3.5-4.5 USM</td>
<td>EF 28-105mm f/3.5-4.5 II USM</td>
</tr>
<tr>
<td>EF 28-105mm f/4-5.6 USM</td>
<td>EF 28-105mm f/4-5.6</td>
</tr>
<tr>
<td>EF 28-135mm f/3.5-5.6 IS USM</td>
<td>EF 28-200mm f/3.5-5.6</td>
</tr>
<tr>
<td>EF 28-200mm f/3.5-5.6 USM</td>
<td>EF 28-300mm f/3.5-5.6L IS USM</td>
</tr>
<tr>
<td>EF 55-200mm f/4.5-5.6 II USM</td>
<td>EF 55-200mm f/4-5.6 USM</td>
</tr>
<tr>
<td>EF 70-200mm f/2.8L USM</td>
<td>EF 70-200mm f/2.8L IS USM</td>
</tr>
<tr>
<td>EF 70-200mm f/2.8L IS II USM</td>
<td>EF 70-200mm f/4L USM</td>
</tr>
<tr>
<td>EF 70-200mm f/4L IS USM</td>
<td>EF 70-300mm f/4-5.6 IS USM</td>
</tr>
</tbody>
</table>

## Macro lenses

<table>
<thead>
<tr>
<th>Lens Configuration</th>
<th>Lens Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 50mm f/2.5 Compact Macro</td>
<td>EF 100mm f/2.8 Macro USM</td>
</tr>
<tr>
<td>EF 100mm f/2.8L Macro IS USM</td>
<td>EF 180mm f/3.5L Macro USM</td>
</tr>
<tr>
<td>MP-E 65mm f/2.8 1-5x Macro</td>
<td>Photo</td>
</tr>
</tbody>
</table>

- You can also correct RAW images taken with the compatible lens even when the extender is attached.
- You can also correct RAW images shot with EF 50mm f/2.5 Compact Macro fitted with Life Size Converter EF.
- The aberration correction function is not available for images shot with a lens other than those given under “Compatible Lenses”. They are therefore not displayed and cannot be used.
- The lens aberration correction function is not available for multiple-exposure RAW images created on the camera.
- EF cinema lenses (CN-E lenses) are not compatible.
Making Corrections
You can make corrections to any of the four aberrations as below, either one at a time or simultaneously.
- Peripheral illumination
- Chromatic aberration (color fringing which occurs in the periphery of an image)
- Color blur (blue or red color blur which sometimes occurs at the edge of the highlighted area of an image)
- Distortions

1 Select an image in the main window.
2 Display the Lens Correction tool palette and checkmark the items to be corrected.

- Check the results of corrections to peripheral illumination or distortions in the full view.
- Check the results of corrections to chromatic aberration and color blur by clicking the area on the image you want to check and then checking the enlargement display section in the top of the window. You can choose from 4 display scales between 1:1 and 1:4 for the enlargement display.
- You can lessen the degree of correction by moving the slider to the left.
- You can respectively correct red chromatic aberration with the [R] slider of the [Chromatic aberration] or blue chromatic aberration with the [B] slider.
- To correct distortion aberration of images shot with a fisheye lens (EF 8–15mm f/4L USM Fisheye or EF 15mm f/2.8 Fisheye), four effects can be selected from the [Effect] list box in addition to [Shot settings] normally used for distortion correction. The level of an effect can be adjusted with the adjustment slider located below [Distortion]. For detailed information on each effect, see "Effects of Distortion Aberration Correction for Fisheye Lenses" (p.68).

Enlargement display section

- For images shot with EF 8–15mm f/4L USM Fisheye, a fine-tune slider is also displayed when you select [Emphasize Linearity] from the [Effect] list box. Adjust the amount of correction for distortion aberration with the adjustment slider, and then adjust with the fine-tune slider if more adjustment is required.
- When the list box for selecting an extender is displayed, select the extender attached at the time of shooting from the list box.

The image is corrected and redisplayed.
In the main window, the [ ] mark is displayed on the image to indicate that the lens aberration correction is applied (p.116).
Effects of Distortion Correction for Fisheye Lenses

- **Shot settings**
  By selecting this option, only the aberration corrections will be performed to correct the optical distortions.

- **Emphasize Linearity**
  This converts the image to a “central projection” style image. This projection method is employed for general lenses. Since central projection displays straight lines as straight lines, a wide-view panoramic image can be obtained by selecting this option. However, the periphery is stretched, resulting in decreased resolution.

- **Emphasize Distance**
  This converts the image to an “equidistant projection” style image. This projection method preserves distance relationships. Equidistant projection displays a distance in the same distance anywhere from the center to the periphery. In particular, when shooting a celestial body such as the celestial sphere, same heights above the horizon (declination) are captured at the same heights. This method is therefore used in such photography as celestial photography (star maps, solar path diagrams, etc.).

- **Emphasize Periphery**
  This converts the image to a “stereographic projection” style image. This projection method emphasizes the periphery. Stereographic projection allows position relationships on a spherical surface, such as N, S, E, W on a map, to be displayed correctly. It is therefore used for world maps and monitoring cameras. By selecting this option, the periphery is stretched and may result in decreased resolution.
Emphasize Center
This converts the image to an “orthographic projection” style image. With this projection method, the center is more emphasized. Since an orthogonal projection allows a subject of the same brightness to be displayed as occupying the same area in the image, this method has typical uses in photography for celestial luminance distributions and center-emphasized animal photography. By selecting this option, the center is stretched and may result in decreased resolution.

When correcting RAW images and if shooting distance information has been saved to the image, the slider is set automatically according to this shooting distance information. However, if no shooting distance information is saved to the image, the slider is set automatically to the right end at infinity position and a [<!> appears above the slider. If the image’s shooting distance is not infinite, you can minutely adjust the distance by operating the slider while looking at the screen.

For RAW images shot with MP-E 65mm f/2.8 1-5x Macro Photo or EF 50mm f/2.5 Compact Macro with Life Size Converter EF, the slider indicator changes to [Magnification factor].

The [Shooting distance information] slider is applied to all the correction items with check marks.

When selecting any of the options, [Emphasize Linearity], [Emphasize Distance], [Emphasize Periphery], or [Emphasize Center], it will yield results similar to that of the selected projection method. However, the conversion does not really apply a change of projection method in a strict sense. Accordingly, be aware that they are not suited for scientific or other such purposes.
Correcting Multiple Images at a Time

You can apply the same corrections to several images by first selecting multiple images in the main window, and then performing correction procedures (p.67).
Also, you can apply the same corrections by copying the recipe of the corrected image and pasting it onto the multiple images (p.84).

Additional information

- Some noise appeared in the periphery of an image after correcting [Peripheral illumination]
  You can reduce the noise by using luminance and/or chromatic noise reduction of the noise reduction function (p.60). However, if you had applied high amount of [Peripheral illumination] correction to the images that have been shot at night or with a high ISO speed, the noise might not be reduced.

- The image appears with less resolution after correcting [Distortion]
  You can make the image similar to the one before correction by applying more sharpness with the sharpness adjusting function (p.61).

- The colors of the image became weaker after correcting [Color blur]
  You can make the image similar to the one before correction by adjusting the color tone (p.47) and/or the color saturation (p.59) to make the color deeper.

- The result of [Color blur] correction cannot be detected
  [Color blur] correction is effective for correcting blue or red color blur which occurs at the edge of the highlighted area of an image. If conditions do not match, correction cannot be made.

Digital Lens Optimizer

This function enables the resolution of images to be increased by removing any remaining aberration related to image-forming capability or any deterioration of resolution resulting from diffraction phenomena. These optical phenomena cannot be corrected under Lens aberration correction (p.65). Correction is achieved using the designed value of each lens. The images that can be corrected are RAW images shot using any of the following "Compatible Lenses". JPEG, TIFF, S-RAW, and M-RAW images cannot be corrected. To use this function, [Lens data] for the lens used to shoot images first needs to be downloaded to your computer. Before using the Digital Lens Optimizer, it is recommended that you set [Sharpness] or [Strength] for [Unsharp mask] for images to 0.

Compatible Lenses

<table>
<thead>
<tr>
<th>Wide angle lenses</th>
<th>Standard and medium telephoto lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 14mm f/2.8L USM</td>
<td>EF 40mm f/2.8 STM</td>
</tr>
<tr>
<td>EF 14mm f/2.8L II USM</td>
<td>EF 50mm f/1.4 USM</td>
</tr>
<tr>
<td>EF 20mm f/2.8 USM</td>
<td>EF 50mm f/1.2L USM</td>
</tr>
<tr>
<td>EF 24mm f/1.4L USM</td>
<td>EF 85mm f/1.2L USM</td>
</tr>
<tr>
<td>EF 24mm f/2.8 IS USM</td>
<td>EF 85mm f/1.8 USM</td>
</tr>
<tr>
<td>EF 28mm f/1.8 USM</td>
<td>EF 100mm f/2 USM</td>
</tr>
<tr>
<td>EF 35mm f/1.4L USM</td>
<td>EF 100mm f/2 USM</td>
</tr>
<tr>
<td>EF 35mm f/2 IS USM</td>
<td>EF 100mm f/2 USM</td>
</tr>
</tbody>
</table>

The periphery of the image may be truncated when [Distortion] correction is made.
### Telephoto lenses

<table>
<thead>
<tr>
<th>Lens Type</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 135mm f/2L USM</td>
<td>EF 200mm f/2L IS USM</td>
</tr>
<tr>
<td>EF 200mm f/2.8L USM</td>
<td>EF 200mm f/2.8L II USM</td>
</tr>
<tr>
<td>EF 300mm f/2.8L IS II USM</td>
<td>EF 300mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 400mm f/2.8L IS II USM</td>
<td>EF 400mm f/4 DO IS USM</td>
</tr>
<tr>
<td>EF 400mm f/5.6L USM</td>
<td>EF 500mm f/4L IS II USM</td>
</tr>
<tr>
<td>EF 600mm f/4L IS II USM</td>
<td></td>
</tr>
</tbody>
</table>

### Zoom lenses

<table>
<thead>
<tr>
<th>Lens Type</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 16-35mm f/2.8L USM</td>
<td>EF 16-35mm f/2.8L II USM</td>
</tr>
<tr>
<td>EF 17-40mm f/4L USM</td>
<td>EF 24-70mm f/2.8L USM</td>
</tr>
<tr>
<td>EF 24-70mm f/2.8L II USM</td>
<td>EF 24-70mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 24-105mm f/4L IS USM</td>
<td>EF 28-70mm f/2.8L USM</td>
</tr>
<tr>
<td>EF 28-135mm f/3.5-5.6 IS USM</td>
<td>EF 28-200mm f/3.5-5.6 USM</td>
</tr>
<tr>
<td>EF 28-200mm f/3.5-5.6</td>
<td>EF 28-300mm f/3.5-5.6 IS USM</td>
</tr>
<tr>
<td>EF 70-200mm f/2.8L USM</td>
<td>EF 70-200mm f/2.8L IS USM</td>
</tr>
<tr>
<td>EF 70-200mm f/2.8L IS II USM</td>
<td>EF 70-200mm f/4L USM</td>
</tr>
<tr>
<td>EF 70-200mm f/4L IS USM</td>
<td>EF 70-300mm f/4.5-5.6 IS USM</td>
</tr>
<tr>
<td>EF 70-300mm f/4.5-5.6 DO IS USM</td>
<td>EF 70-300mm f/4.5-5.6 IS USM</td>
</tr>
<tr>
<td>EF 100-400mm f/4.5-5.6L IS USM</td>
<td>EF 200-400mm f/4L IS USM</td>
</tr>
</tbody>
</table>

### Macro lenses

<table>
<thead>
<tr>
<th>Lens Type</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 50mm f/2.5 Compact Macro</td>
<td>EF 100mm f/2.8 Macro USM</td>
</tr>
<tr>
<td>EF 100mm f/2.8L Macro IS USM</td>
<td>EF 180mm f/3.5L Macro USM</td>
</tr>
</tbody>
</table>

---

### Using the Digital Lens Optimizer

1. **Check the status of [Lens data] for [Digital Lens Optimizer].**

   ![Image showing lens data status](image)

   - **[Not Available]** is displayed for an image shot with a non-compatible camera or lens, or for a non-compatible image such as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot be used for these images.
   - If [No] is displayed, proceed to step 2. To use the function, you need to download the lens data for the lens used when shooting the image. It is recommended that you check the lens used when shooting the image beforehand. The lens used can be checked using the image information and shooting information displays. You can also check it with the menu that appears when you right-click with the mouse on an image.
   - If [Yes] is displayed, proceed to step 4.

---

⚠ The Digital Lens Optimizer is also available for images shot with an extender attached to a compatible lens.

⚠ You cannot use the Digital Lens Optimizer with multiple-exposure RAW images created on the camera.

⚠ EF cinema lenses (CN-E lenses) are not compatible.
2 Click the [ ] button.

→ The [Add or Remove lens data] window appears.

3 Checkmark the checkbox for the lens used to shoot the image, and click the [Start] button.

→ The lens data is downloaded to your computer.

→ When the downloading of the lens data ends, the indication for the lens data changes to [Yes].

- You can download the data for up to 30 lenses at the same time.
- If you remove the check mark from the checkbox for already-downloaded lens names and click the [Start] button, the lens data will be deleted from your computer.

⚠️ To use this function, an environment with Internet access (subscription to a provider, browser software installed and an in-place line connection) is required.

⚠️ An administrator-level privilege is required for this operation.

⚠️ Before you click the [ ] button in step 2, Lens data [No] may be displayed instead of [Not Available] for non-compatible images.

⚠️ Depending on the type, current state, etc. of software running on your computer, the download of the lens data may fail. If it occurs, wait for a while then try downloading the data again.
4. Checkmark the [Digital Lens Optimizer] checkbox and adjust the image.

- Use the slider to adjust the Digital Lens Optimizer effect.
- If no shooting distance information is saved to the image, the shooting distance slider is set automatically to the right end at infinity position and a [<!>] appears above the shooting distance slider.
- Images cannot be corrected for [Chromatic aberration] in the lens aberration correction tool pallet if the Digital Lens Optimizer has been applied.
- In the main window, the [ ] mark is displayed on the image to indicate that the Digital Lens Optimizer is applied (p.116).

**Adjusting Image Sharpness**

You can also use this palette to adjust the image sharpness. For information on making adjustments, see “Adjusting Image Sharpness” in “Editing with the Basic Adjustment Tool Palette” (p.51).

- Since the lens data downloaded with DPP version 3.x is not compatible with DPP version 4.x, the lens data must be downloaded again.

Editing with the Dust Delete/Copy Stamp Tool Palette

You can use this tool palette to erase dust and other marks in a shot image and to correct an image by copying part of the image and pasting it onto an unnecessary part of the image. Note that you can use the functions in this tool palette with JPEG and TIFF images as well as RAW images.

Dust Delete/Copy Stamp Tool Palette

Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images can be used to automatically erase dust spots.

1. Select an image with dust delete data attached in the main window, etc.
2. Display the Dust Delete/Copy Stamp tool palette.
   - You cannot make adjustments with the Dust Delete/Copy Stamp tool palette in a window that only shows thumbnails.
3. When the image has redrawn itself, click the [Apply Dust Delete Data] button.
   → Dust spots are erased in a single operation.
4. Return to the main window.
Additional information

- The dust-erased image can be reverted to its original condition at any time
  A dust-erased image is displayed or printed as a dust-erased image. However, since the dust on the image is not actually erased, you can always revert to the original image by clicking the [button in the Dust Delete/Copy Stamp tool palette or performing the "Re-Editing an Image" procedure (p.82).

- Printing dust-erased images
  You can print as a dust-erased image by printing it in DPP.

- To erase dust spots that cannot be erased with the automatic dust erasure processing
  In automatic dust erasure processing, dust spots are erased based on information relating to dust saved in the Dust Delete Data. However, there may be cases where you will not be able to erase dust spots depending on the type of dust. If this occurs, erase those dust spots using the repair function (p.76) or the copy stamp function (p.78).

- The image becomes a dust-erased image when converted and saved
  The dust-erased RAW image actually becomes a dust-erased image when converted to a JPEG or TIFF image and saved (p.80).

- Applying the dust erasure result to another image
  You can apply dust erasure to the same place in another image by clicking the [Copy] button to copy the dust erasure results and then displaying the other image to which you want to apply the results and clicking the [Paste] button.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete Data, and then select the [Adjustment] menu ➔ [Apply Dust Delete Data].
 ➔ Dust spots in all the selected images are erased in a single operation.
Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

1. In the main window, select the image from which you want to erase dust spots.
2. Display the Dust Delete/Copy Stamp tool palette.
3. Click the point from where dust is to be erased.

4. Click the button that matches the dust spot to be erased.
   - If the dust spot is dark in color, click the [ ] button, and if the dust spot is light in color, click the [ ] button.
   - When you move the cursor over the image, the dust erasure range is indicated with [ ].

5. Place the dust spot to be erased within the [ ] and click.

   - The dust spot within the [ ] is erased.
   - Click on another part of the image to continue erasing dust spots within the displayed image.
   - To erase dust in another part of the image, either right-click with the mouse, or click the button clicked in step 4 again to cancel dust erasure processing and perform the operation again from step 3.
   - When the dust spot cannot be erased, [ ] is displayed.

6. Return to the main window.

   - The display changes to 100% view.
   - The display position can be changed by dragging.
**Additional information**

- **Click several times when dust spots are not erased completely**
  Where unwanted dust spots are not erased even after performing step 5 once, they may be erased completely when you click several times.

- **Mainly spots of dust can be erased with the repair function**
  Spots of dust can be erased with the repair function. You may be unable to erase lines of dust. In this case, use the copy stamp function (p.78).

- **The dust-erased image can be reverted to its original condition at any time**
  A dust-erased image is displayed or printed as a dust-erased image. However, since the dust on the image is not actually erased, you can always revert to the original image by clicking the [ ] button in the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing an Image” procedure (p.82).

- **Printing dust-erased images**
  You can print as a dust-erased image by printing it in DPP.

- **The image becomes a dust-erased image when converted and saved**
  The dust-erased RAW image actually becomes a dust-erased image when converted to a JPEG or TIFF image and saved (p.80).

**Useful functions of the copy stamp window**

- **Switch between full screen display/normal screen display using shortcut keys**
  You can also switch between full screen display/normal screen display by pressing the <Alt> + <Enter> keys.

For images shot with ISO speed range expansion set, noticeable noise may make it difficult to view dust spots in the copy stamp window, so using this function is not recommended.
Erasing Unwanted Parts of an Image (Copy Stamp Function)
You can correct an image by pasting a section copied from another part of the image to an unwanted part of the image.

1. **Follow steps 1 to 3 in “Manually Erasing Dust (Repair Function)” (p.76).**

2. **Specify the section to be copied.**
   - Click on the section that is to be the copy source after clicking the [Select Copy Source] button.
   - To change the section that is to be the copy source, perform the operation above again.
   - To fix the position of the copy source, checkmark [Fix Copy Source position].

3. **Correct the image.**
   - Click or drag on the part of the image you want to modify. [+] in the window indicates the copy source and [-] indicates the copy destination.
   - The copied image is pasted in the position to which it was dragged.
   - For [Pen type], you can select from [Brush] (the pasted image’s borders simulate a brush) and [Pencil] (the pasted image’s borders are sharp).

4. **Return to the main window.**
Setting Work Color Space

A different work color space (p.111) from the default settings (p.118) can be set for each image.

Display the Settings tool palette ➔ select the color space to be set.

Settings tool palette

A color space set individually does not change even when the default setting is changed

If you set an image with a color space different to the default setting and then subsequently change the default color space setting (p.111), this default setting will not be applied and the individually set color space will remain.

💡 The color space of a RAW image can be changed freely as many times as required

Since only the image processing conditions information changes, the color space of a RAW image can be changed at any time.
Saving Editing Contents to an Image

All the contents adjusted with the tool palette (recipe) can be saved to the image or saved as a separate image.

Select the [File] menu ➤ desired item.

1. Select the image to be converted.
2. Select the [File] menu ➤ [Convert and save].

Your adjustments are saved to the image.

Saving as a separate image

To view, edit and print a RAW image with software other than DPP, convert to a more versatile JPEG or TIFF image and save. If a JPEG or TIFF image is saved as described below, the image can be saved as a separate image with the adjustments (recipe) applied to it. The image is saved as a separate image, so the original image remains unaffected.

1. Select the image to be converted.
2. Select the [File] menu ➤ [Convert and save].

The [Convert and save] window appears.
Specify the necessary settings, and then click the [Save] button.

- By default, the image is converted and saved to a JPEG image with the highest image quality, without changing the image size. Change the settings according to your requirements.

- The RAW image is converted to a JPEG or TIFF image which is then saved as a new image in the specified save destination.

![Image conversion screen with save options](image)

- **Select the save destination**
- **Click and save**
- **Enter a file name and select an image type**

To save the developing/editing results for the version you are currently using

DPP's RAW image development processing technology is continually being improved upon so that you can perform the latest image processing more appropriately. Meaning that, between two different versions of DPP, processing results may differ very slightly even if with the same RAW image data, or the results of significant editing of RAW image data with an attached recipe may be different.

When you want to save the developing or editing results of the version you are currently using as it is, saving the image as a separate file (p.80) is recommended.

- By saving as a separate JPEG or TIFF image as explained above, some image deterioration that accompanies editing/saving occurs as when editing with general image editing software.
- By saving as explained above, a trimmed image (p.62) or dust-erased image (p.74 to p.78) actually becomes a trimmed image or dust-erased image.
Re-Editing an Image

Only the image processing conditions are changed in images adjusted with the tool palette (p.39 to p.79), so the “original image data itself” remains unaffected. (The trimming range or dust-erasure information of a cropped image (p.62) or dust-erased image (p.74 to p.78) is simply saved to the image.)

For this reason, you can undo any adjustments saved (p.80) to the image, trimming range and dust-erasure information, and revert to the condition when last saved, or when the image was shot.

1 Select the image that is to be re-edited.

2 Select the [Adjustment] menu \(\rightarrow\) desired item.

\[\text{Adjustment}\]
\[
\begin{array}{ll}
\text{Rotate Left} & \text{Ctrl}+\text{L} \\
\text{Rotate Right} & \text{Ctrl}+\text{R} \\
\text{Apply Dust Delete Data} & \\
\text{Work color space} & \\
\text{Revert to last saved settings} & \text{Ctrl}+\text{Alt}+\text{Z} \\
\text{Revert to shot settings} & \text{Ctrl}+\text{Shift}+\text{Z} \\
\end{array}
\]

\(\rightarrow\) The image reverts to the conditions of the selected item.
**Utilizing Adjustment Contents (Recipe)**

All the adjustment contents (recipe) made using the tool palette can be saved as an individual recipe file (extension “.dr4”) and loaded and applied to another image.

You can edit images efficiently by selecting and adjusting one image from images shot with the same shooting environment and batch applying the adjustment results to a large number of images.

![RAW image data](image1)

![JPEG, TIFF image data](image2)

Contents adjusted using the tool palette can be handled individually as a recipe file (extension “.dr4”).

- A recipe file with contents that can only be adjusted in RAW images are not reflected even if it is applied to a JPEG or TIFF image.
- Recipes are not compatible between DPP version 4.x and DPP version 1.x to 1.3. Images with DPP version 1.x to 1.3 recipe files attached are displayed with the shot settings in DPP version 4.x. Conversely, images with DPP version 4.x recipe files attached are displayed with the shot settings in DPP version 1.x to 1.3.
Copying a Recipe and Applying to Another Image
You can copy a recipe of an edited image and then apply it to another image.

1 Select the image with the recipe you want to copy.
2 To copy all items of a recipe, select the [Edit] menu \(\text{} [\text{Copy recipe}].\) To select and copy some items of a recipe, select the [Edit] menu \(\text{} [\text{Copy selected recipe}].\)
   \(\rightarrow\) The recipe is copied.
3 Select the image to which the recipe is to be applied and then select the [Edit] menu \(\text{} [\text{Paste recipe}].\)
   \(\rightarrow\) The recipe is applied to the image.

Saving a Recipe as a File
1 Select an edited image, and then select the [Edit] menu \(\text{} [\text{Save recipe in file}].\)
   \(\rightarrow\) The [Save recipe in file] dialog box appears.
   - To save all of a recipe, select the [Save all recipes] option in the window displayed.
   - To select and save recipe settings, select the [Save selected recipes] option in the window displayed and then click the [Specify Recipe Details] button. In the window displayed, checkmark the recipe settings to be saved and then click the [OK] button.
2 Select the destination folder, enter a file name, and then click the [Save] button.
Loading and Applying Recipes

1. Select the image to which a recipe is to be applied, and then select the [Edit] menu ➤ [Read and paste recipe from file].
   ➔ The [Open] dialog box appears.

2. Select a recipe and click the [Open] button.
   ➔ The recipe is applied to the image.
Adjusting by Comparing Multiple Images

You can synchronize the areas in different images to be displayed among multiple preview windows, and adjust images while comparing them.

1. In the preview window, display the multiple images to be compared.

2. Align the images.
   - Select the [Window] menu ➤ [Arrange horizontally] or [Arrange vertically].
   ➤ The preview windows are aligned.

3. Select the [Preview] menu ➤ [Sync preview position] and [Sync preview display size].

4. Enlarge the image.
   - Enlarge and display any of the preview windows.

   ➤ Other preview windows will also be displayed in the same position/enlargement ratio.

5. Move the area to be displayed.
   ➤ If you move the enlargement display area in one of the preview windows, the enlargement display area will also change in all other preview windows.
   - To cancel synchronization, select the [Preview] menu ➤ [Sync preview position] and [Sync preview display size] again.

---

Synchronization only applies to the enlargement display position and the enlargement ratio. Adjustments to the images are not synchronized.
Editing Efficiently

Editing in the Edit Image Window

The thumbnail display and the preview window are combined, and images can be edited efficiently while quickly switching between images to be edited. Select the images to be edited beforehand in the main window.

1. In the main window, select the images you want to edit.

2. Switch to the edit image window.

   - In the main window, select the images you want to edit.
   - Switch to the edit image window.

   ![Edit Image Window](image)

   Click

   → The main window switches to the edit image window.

   **Edit image window**

   Change the display magnification

   Select the image to be edited

   The selected image is displayed as an enlargement in the middle of the window

   - For information on icons displayed on the frame of a thumbnail, see “Image Frame Information in the Main Window and Edit Image Window” (p.116).
   - The tool palettes, navigator palette, and histogram palette are displayed and you can edit the image.
   - To revert to the condition before the last operation performed on the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> + <Z> keys.
4 Click the area you want to enlarge.

- The area you clicked is enlarged to 100% (actual pixel size).
- To change the display area, drag on the image or drag the enlargement display area (p.14) of the navigator palette.
- Click again to revert to the full view ([Fit to window]).
- To return to the main window, click the [ ] button on the toolbar.

Changing the Thumbnail Display Position to Horizontal
Select the [View] menu ➤ [Horizontal Thumbnails].

- If you select [Vertical Thumbnails], the thumbnail display reverts to the vertical position.

With the edit image window, you can only select images from a folder. To gather images from several folders for editing, see “Gathering and Editing Images in the Collection Window” (p.89).
Gathering and Editing Images in the Collection Window

You can gather selected images together in Collection folders for viewing, comparison and editing.
You can gather images from several folders as well as from a single folder, allowing you to work with them efficiently.

1 Click [+ Add collection] in the [Collection] area in the main window.

   ➔ A new collection folder is created in the [Collection] area.
   • Enter a name for the collection folder.
   • To create additional collection folders, repeat the operation. Up to 20 folders can be created.

2 Select the [File] Menu ➔ [Select collection], and select a collection folder to gather images from the collection folder names displayed.

   ➔ Images in the selected folder are displayed.

3 Select images or image folders in the main window. Select the [File] menu ➔ [Add to collection].
   ➔ The images are added to the selected collection folder, and the number of selected images in the collection folder is displayed. When an image set to single-image display (p.18) is added, the number of images is indicated as two images.
   • You can also add images to a collection folder by selecting images and folders and then selecting [Add to collection] from the menu that appears when you right-click the mouse.

4 Select a collection folder in the [Collection] area.
Check the displayed images.

To remove images from collection folders

- **Removing selected images**
  Select images in a collection folder, select images, and select [Remove from collection] in the [File] menu. (You can also remove images from a collection folder by selecting the images, right-clicking with the mouse, and selecting [Remove from collection] from the menu that appears.) Note that even if you remove an image from a collection folder, the original image remains unaffected.

- **Removing all images**
  Select [Clear collection] in the [File] menu. Note that even if you remove all images from a collection folder, the original images remain unaffected.

- **Deleting a collection folder**
  Select a collection folder in the collection area, then select [Delete collection] from the menu that appears when you right-click with the mouse. Note that if you delete a collection folder, the original images remain unaffected.

Modify the displayed images.

- Edit the displayed images.
  - Displayed images are retained in the collection folders even after exiting DPP.

**Modifications to the image are applied to the original image**
Modifications made to images in a collection folder are all applied to the original image.
Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred to Adobe Photoshop.

Select the [Tools] menu ➤ [Transfer to Photoshop].

Photoshop starts up and the transferred image is displayed.

A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at a time, see p.102.

- Compatible versions of Photoshop are 7.0 or later.
- Transferred images are automatically converted to TIFF images (16bit) to which an ICC profile (p.117) is added. The ICC profile contains information about [Preferences] (p.111) or work color space (p.79) set for each image as described and the appropriate color information is relayed to Photoshop.
- When you exit Photoshop, only the original RAW image remains, and the transferred image will disappear. Saving the transferred image as a separate image in Photoshop is recommended.
Customizing the Main Window Toolbar

You can display buttons for frequently-used functions in the main window’s toolbar.
You can also change how the buttons are laid out.

1 Select the [Tools] menu ➤ [Customize toolbar].
   → The [Configure Toolbar] window appears.

2 Select functions to display in the toolbar.

   ![Configure Toolbar Window]

   - To rearrange buttons, select the function you want to change, and then click the [Move Up] or [Move Down] button.
   - After specifying settings, click the [Close] button and close the window.
   → The settings are applied to the main window’s toolbar.
5 Printing Images

Printing an Image .................................................... 94
Printing with Shooting Information ............................ 95
Plug-in printing.......................................................... 96

Contents
Printing an Image

You can print images with a printer. As an example, the procedure to print one image on one sheet of paper is described here.

1. Select the image to be printed.

2. Select the [File] menu ➤ [Print].

   - Select the image to be printed.
   - Select the [File] menu ➤ [Print].

The printer’s print settings dialog box appears.

3. Print.
   - Specify the optimum settings for printing photographs in the printer’s print settings dialog box and click the [OK] button.
   - Printing begins.
Printing with Shooting Information
You can freely layout one image on one sheet of paper and print together with titles and shooting information, etc.

1. Select one image to be printed.
2. Select the [File] menu ▶ [Print with detailed setting].
3. Specify the required settings for printing, and then click the [Print] button.

   - The image can be moved by dragging.
   - Drag the four corners of the image to change the size.
   - For the shooting information, click [ ] on the [Text] tab sheet and select the necessary items in the window that appears.

   To maintain the settings
   The settings of each tab sheet in step 3 are memorized when the [Apply] button is clicked (excluding the contents of the [Text] tab sheet). The settings can be applied to another image when printing.

   - You can set printer profiles (p.111).
   - If CMYK simulation is set, the image is printed in the set colors.
Plug-in printing

   → The Plug-In starts up.

2. Specify the required settings for printing photographs and then print.
Batch Apply White Balance to Images (Personal White Balance) ............................................................... 98
  Registering Personal White Balance .................................................. 98
  Applying Personal White Balance ...................................................... 99
Batch Save as JPEG or TIFF Images (Batch Processing) ................................................................. 100
Batch Transfer Images to Image Editing Software ................. 102
Batch Change the File Name of Images.................. 103
  Changing the File Name of Images in the Order in the Main Window ................................................................. 103
Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific shooting environment can be registered as personal white balance. You can then perform efficient white balance adjustment by applying this personal white balance to a large number of RAW images shot in the same shooting environment. Personal white balance data for DPP version 4.0 or earlier cannot be applied.

Registering Personal White Balance

1. Adjust the white balance (p.44, p.45).
   - To adjust white balance, select a setting other than [ ] from the [White balance adjustment] list box (p.43). Registering the adjustments is not possible if [ ] is selected.

2. In the Basic adjustment tool palette, click the [Register] button.
   - The [Register personal white balance] dialog box appears.

3. Select the button number to be registered from the list and click the [OK] button.

To use the registered personal white balance on another computer

1. In step 3, click the [Save] button to write as a file.
2. Copy the file to another computer.
3. In DPP on another computer, display the window of step 3.
4. Click the [Load] button and in the window that appears, select the copied file.

You cannot change or adjust white balance with multiple-exposure RAW images created on the camera.
Applying Personal White Balance

1. In the main window, select the image to which a personal white balance is to be applied.

2. Select the [View] menu ➔ [Tool palette].

3. Click the personal white balance number button that is to be applied.

→ Personal white balance is applied to all the selected images.
Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile JPEG or TIFF images.
The images are saved as separate images, so the RAW images remain unaffected.

1. In the main window, select multiple images to be converted.
2. Select the [File] menu > [Batch process].
4. Specify the required settings, and then click the [Execute] button.

In the processing dialog box, click the [Exit] button.

- The batch processing dialog box appears and saving begins.
- When all the images are saved, the [Exit] button appears in the batch processing dialog box.

If you have selected [New file name] in [File name], [Sequence number] has to be set.

By saving as explained above, a trimmed image (p.62) or dust-erased image (p.74 to p.78) actually becomes a trimmed image or dust-erased image.
Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As] (p.80) to edited RAW images.

To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually being improved upon so that you can perform the latest image processing more appropriately. Meaning that, between two different versions of DPP, processing results may differ very slightly even if with the same RAW image data, or the results of significant editing of RAW image data with an attached recipe may be different.

When you want to save the developing or editing results of the version you are currently using as it is, converting and saving images as JPEG or TIFF images is recommended.

Skillful batch saving

While saving is being performed, you can continue working in another window

Since the saving function operates independently in the background, you can continue with an operation in another window such as the main window or the preview window during the saving process.

To convert all images and save, do not select an image in the main window

If you do not perform step 1 and perform step 2 with no image selected in the main window, all the images displayed in the main window will be converted and saved.
Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike “Transferring a RAW Image to Photoshop” (p.91), you transfer images that have first been converted and saved as a separate image, so the transferred image will not be deleted after exiting the destination software. The software used here as an example is Adobe Photoshop.

1. In the main window, select multiple images to be transferred.
2. Select the [File] menu \[Batch process].
3. Perform settings required for transferring (e.g. file format).
4. Checkmark [Open image using software].

5. Select Photoshop.
   - In the [Open] dialog box, select a Photoshop file or a shortcut and click the [Open] button.

6. Click the [Execute] button.
   - The processing dialog box appears and batch transfer begins.
   - When the first image has been transferred, Photoshop starts up and transferred images are displayed in transferred order.

To reset the transfer destination to another software, click the [Browse] button in [Image transfer settings], and in the [Open] dialog that appears, select the software and click the [Open] button.
Batch Change the File Name of Images

1. In the main window, select multiple images of which the file names are to be changed.
2. Select the [Tools] menu ➔ [Start Rename tool].
   ➔ The rename window appears.
3. Specify the required settings and click the [Execute] button.

   ➔ Processing begins and the file names are changed.

Changes cannot be made when the file name is duplicated

If a file name in red text appears in [Modified File Name], the file name is duplicated. Changes cannot be made if even one file name is duplicated. Change the settings so that duplication does not occur.

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window, you can change in one operation the names of the files for the images, in the order they were rearranged.

1. Change the order of the images in the main window (p.31).
2. In the main window, select multiple images of which the file names are to be changed.
3. Select the [Tools] menu ➔ [Start Rename tool].
4. Select [Fit to main window].
5. Specify the required settings.
   • To copy an image, checkmark [Copy and Rename].
6. Click the [Execute] button.
   ➔ The file names are changed and the order in the main window is maintained.

You cannot start up the rename tool from the [Collection] window (p.89).
Remote Shooting

You can perform remote shooting by using “EOS Utility” which enables communication with a camera in combination.
For remote shooting, “EOS Utility Ver. 3.x” must be installed on your computer.

1. Click the [Remote Shooting] button on the toolbar in the main window.

   - Remote shooting setting screen appears.

2. Enter settings for [Destination] and a name for [Destination folder] in the remote shooting setting window, then click the [OK] button.

   - A folder for saving the images shot with remote shooting will be created.
   - Remote shooting window appears.

3. Connect a camera and a computer, and set the camera’s power switch to <ON>.

4. Click the [Live View] button.

   - You can perform shooting while checking the image by switching the window to multi-layout.
   - Live View window of “EOS Utility” appears.
5 Specify the required settings.

- For detailed instructions on setting procedures, refer to “EOS Utility Instruction Manual” (PDF electronic manual).

6 Click the [Settings] button.

- The capture window of “EOS Utility” appears.

7 Specify the required settings.

- For detailed instructions on setting procedures, refer to “EOS Utility Instruction Manual” (PDF electronic manual).

8 Take the picture.

- For detailed instructions on setting procedures, refer to “EOS Utility Instruction Manual” (PDF electronic manual).
The shot image is displayed.

- The shot image will be saved in the folder created in step 2.
- The images in the folder mentioned above will be displayed in the thumbnail display area.
  You can also create a sub-folder in the folder mentioned above to save images. To create a sub-folder, click the [Create subfolder] button on the remote shooting window, enter [Folder name] on the screen appeared, then click the [OK] button.

In the cases below, perform shooting with EOS Utility.
- You want to autofocus with EOS Utility’s shoot button
- You want to perform continuous shooting
- You can perform shooting while comparing the shot image with a pinned image by pinning an image (p.16). This is convenient for image selection.
8 Specifying Preferences

Specifying Preferences ........................................... 109
  General Settings ................................................... 109
  Image processing .................................................. 110
  Color Management ............................................... 111
  View Settings ..................................................... 112
Specifying Preferences

You can change the various functions of DPP in the [Preferences] window. Check the contents of each window and set. Refer to the detailed explanations if available, as well as to each window.

1 Select the [Tools] menu ▶ [Preferences].
   → The [Preferences] window appears.

2 Select a tab sheet, specify the settings, and then click the [OK] button.

General Settings

You can specify the folder that opens when DPP is started up, the display order of thumbnails, etc.

- **Thumbnail order**
  You can set the order of images which have been rearranged in the main window to be maintained or not maintained (p.31).
  If you checkmark the checkbox, the order of the rearranged images is maintained even if you exit DPP or select another folder in the folder area.
  If you remove the check mark, the order of the rearranged images is not maintained and reverts to the previous order when you exit DPP or select another folder in the folder area.

- **Default value of output resolution**
  When saving JPEG or TIFF images created by converting RAW images (p.80, p.100), the resolution of the JPEG or TIFF images can be set.
Image processing
You can specify settings for processing images in DPP.

JPEG image quality
[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise particular to JPEG images.
This setting is also effective when RAW images are converted to JPEG images and saved (p.80, p.100) and for JPEG images that to be saved with a different name. The higher the JPEG image’s compression rate, the better the effect. And when the compression rate is low, the effect of noise reduction may not be noticeable.

Modified Picture Style settings
You can select whether the [Color tone], [Color saturation], [Contrast], [Unsharp mask] and [Sharpness] settings will be changed accordingly or retained, when you change the Picture Style.
• If you checkmark the checkbox, the [Color tone], [Color saturation], [Contrast] and [Sharpness] settings will be changed to match the camera’s preset settings, when you change the Picture Style.
• If you remove the check mark, the [Color tone], [Color saturation], [Contrast] and [Sharpness] settings will be retained, even if you change the Picture Style.
Color Management

You can specify settings relating to color management, such as settings for work color space, conditions for color matching, etc.

- Default settings of Work color space
  You can select the color space (p.118) to be applied as a default setting of RAW images from five types. The color space set will be applied as the color space when a RAW image is converted and saved (p.80, p.100) or printed (p.94 to p.96).
  - If you change the color space, and you restart DPP, the set color space is applied as the default color space.
  - You can check the color space that is set in an image in all windows except the quick check window.
  - If you checkmark [Use shooting color space as work color space], the color space specified with the camera when the image was shot will be set as work color space.

- Changes are not applied to the edited image
  Even if the default setting is changed, the new default setting is not applied to edited (i.e., adjusted using the tool palette, cropped, dust-erased) images. Change the settings individually.

  - You can set a color space that is different from the default settings for each image (p.79).

- Color matching settings (color setting of the monitor)
  Where a profile (p.117) is attached to the monitor you are using, you can display an image in more faithful colors by setting the profile.
  - If you select [Use the OS settings], the color profile set in Windows will also be applied in DPP. If you are using multiple monitors, the profile set for each monitor is applied to DPP.
  - Select the [Monitor profile], click the [Browse] button. You can select a profile for your monitor in the dialog box that appears.

- Precise coloring with a third-party monitor color reader
  If you use a profile created using a third-party monitor color reader, images can be displayed in even more precise colors.

- Printing profile (color setting of the printer)
  Where a profile is not attached to the printer you are using to print images, you can print an image, simulating the colors displayed on screen by setting the profile in DPP.

  - When you set a profile for printing in DPP, set the color adjustment function of the printer driver to off. If it is left on, the image may not be printed in colors close to those displayed on screen.
View Settings

You can set layout for screen display.

- **User interface size and position**
  By checkmarking the [Restore defaults at startup] checkbox, the positions and sizes of each window revert to their original settings for next time you start up DPP. The checkmark is also removed from the checkbox for the next startup.
Reference

113

Troubleshooting .......................................................... 114
Deleting the Software (Uninstalling) ................ 115
Image Frame Information in the Main Window
and Edit Image Window ............................................. 116
Glossary ................................................................... 117
Index ........................................................................... 119
   About This Instruction Manual .......................... 123
   Trademarks ......................................................... 123

Introduction

Contents

Downloading Images

Viewing Images

Editing Images

Printing Images

Processing Large Numbers of RAW Images

Remote Shooting

Specifying Preferences

Reference/ Index

Troubleshooting .......................................................... 114
Deleting the Software (Uninstalling) ................ 115
Image Frame Information in the Main Window
and Edit Image Window ............................................. 116
Glossary ................................................................... 117
Index ........................................................................... 119
   About This Instruction Manual .......................... 123
   Trademarks ......................................................... 123

Introduction

Contents

Downloading Images

Viewing Images

Editing Images

Printing Images

Processing Large Numbers of RAW Images

Remote Shooting

Specifying Preferences

Reference/ Index
Troubleshooting

If DPP is not operating correctly, refer to the subjects below.

Installation can not be completed correctly

- Select an administrator-level privilege ([Computer administrator], [Administrator], etc.) when setting the user. You cannot install the software if the user setting other than an administrator-level privilege is selected. For detailed information on selecting an administrator-level privilege, refer to your computer User’s Manual.

DPP does not work

- DPP does not operate correctly on a computer if its system requirements are not met. Use DPP on a computer with compatible system requirements (p.2).
- Even if your computer has the RAM capacity (memory) described in the system requirements (p.2), if other applications are running at the same time as DPP, you may not have sufficient RAM (memory). Exit any applications other than DPP.

The card reader does not detect the SD card

- Depending on the card reader and computer OS used, SDXC cards may not be correctly detected. In such a case, connect your camera and computer with the provided interface cable, and transfer the images to your computer using EOS Utility.

Images are not displayed properly

- Images that are not supported by DPP are not displayed. There are various types of JPEG and TIFF images, so JPEG images other than Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than Exif compatible images may not to be displayed properly (p.2).

A recipe could not be pasted (applied) to another image

- Contents that can only be adjusted for RAW images cannot be applied as a recipe to JPEG images or TIFF images.

Colors are subdued in the image when viewed with other software

- If a RAW image which has a color space other than sRGB is converted and saved as a JPEG or TIFF image (p.79, p.111), the colors will be subdued when viewed in software that is only compatible with sRGB color space. In such a case, set the RAW image’s color space to sRGB, convert and save again as a JPEG or TIFF image, and then view the image.

The colors of the image displayed on screen and the colors of the printed image do not match

- If the color of the monitor that displays an image is not adjusted correctly, or if the profile for a printer that is to print image is not set up, the color of the image displayed on screen and the color of the printed photograph may differ greatly. If the color of the monitor that displays images is corrected (p.111) and the profile for a printer is set up correctly (p.111), the color of a printed photograph and the color of an image on screen can be more closely matched. Using a Canon printer automatically sets up the profiles for the printer, so you only need to set the color of the monitor to bring the colors closer to each other.

Printing a large number of images in batches cannot be performed

- If a large number of images are printed in batches, printing may stop in the middle or the images may not be printed. Reduce the number of images to print or increase the memory on your computer.
Deleting the Software (Uninstalling)

- Exit any applications before uninstalling the software.
- Log in under an administrator-level privilege when uninstalling the software.
- Uninstall the software according to the OS software uninstalling method.
- To prevent computer malfunctions, always restart your computer after you have uninstalled the software. Re-installing the software without first restarting your computer is particularly likely to result in computer malfunctions.
Image Frame Information in the Main Window and Edit Image Window (p.10, p.87)

- **Trimming (cropping) range** *(p.62)*
- **Check mark** *(p.28, p.29)*
- **Pinned image setting mark** *(p.16)*
- **Multiple image display mark** *(p.17)*
- **Image type** *(p.28, p.29)*
- **Rating mark** *(p.28, p.29)*
- **Digital Lens Optimizer mark** *(p.71)*
- **File name**
- **GPS mark** *(p.3)*
- **Lens aberration correction mark** *(p.67)*
- **Unsaved editing content mark**

*1 Displayed on RAW+JPEG images displayed as a single image *(p.11).* [RAW] is displayed in RAW images.

*2 When aspect ratio information is attached to a shot image, the image is displayed as a cropped image.

*3 Displayed on images shot on a GPS function-compatible Canon camera.
**RAW image**

EOS DIGITAL camera RAW images are recorded in an uncompressed 14bit or 12bit format. Because RAW images are special images in an undeveloped status, you need software with development processing functions such as DPP in order to view them. The advantage of the undeveloped RAW images is that you can make a variety of adjustments to RAW images with almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

**JPEG image**

The most ordinary image in non-reversible compressed 8bit format. The advantage of this is that by saving at a high compression rate, the file size can be small, even for image data that has a high pixel count. Because during saving and compression part of the data is thinned out to make the file size small, every time you edit or save, the image deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is modified, and no overwriting or compression occurs so the original image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

**TIFF image**

Bitmap-format image recorded in a 8bit/16bit uncompressed format. Because TIFF images are in uncompressed format, they are suitable for saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

**Recipe**

The “Image processing conditions information” for RAW images that can be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF images that use “recipes” as with RAW images.

**bit number**

Binary unit of information volume in the color of an image. The number shows the number of bits per pixel. The larger the number of bits, the more the color numbers and the gradation becomes smoother. A one-bit image is a black-and-white image.

**Color Management System (Color Matching)**

Digital cameras that shoot images, monitors that display images, and printers that print images each have a different way of creating color. For this reason, there may be a difference between the color of an image when viewed on a monitor and when printed.

A color management system is a system for managing color in order to bring these colors closer together. With DPP, you can more closely match color between different devices with ICC profiles between different devices.

**ICC profiles**

ICC profiles are files containing color information such as color characteristics and color space for various devices, set by the ICC (International Color Consortium). Most devices such as the monitor we use to view images or the printer we use to print images can be managed (color management) using these ICC profiles and the color between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

**Tone Curve**

A tone curve shows values before adjustment (input) as the horizontal axis on a graph, and the values after adjustment (output) as the vertical axis. Since the values of before adjustment and after adjustment are the same before any adjustment is made, the tone curve displays as a straight line from bottom left to top right, and by changing this tone curve, you can adjust in detail the image’s brightness, contrast and color. The more you go right on the horizontal axis, the more the plus value it becomes, and the higher you go on the vertical axis, the more the plus value it becomes.
**Color space**

A color space is the reproducible color range (color gamut characteristics). DPP supports the following five kinds of color space.

- **sRGB**: Standard color space for Windows. Widely used for the standard color space of monitors, digital cameras, and scanners.
- **Adobe RGB**: A wider color space than sRGB. Mainly used for printing for business purposes.
- **Apple RGB**: Standard color space for Macintosh. A slightly wider color space than sRGB.
- **ColorMatch RGB**: A slightly wider color space than sRGB. Mainly used for printing for business purposes.
- **Wide Gamut RGB**: A wider color space than Adobe RGB.

Refer to the color chart below for the color area of each color space.

**Color chart of color spaces compatible with DPP**

Color range that can be seen by the human eye

**Color chart of color spaces compatible with DPP**

<table>
<thead>
<tr>
<th>Color Space</th>
<th>Gamma Value</th>
<th>White Point (Color Temp.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>sRGB</td>
<td>2.2</td>
<td>6500K (D65)</td>
</tr>
<tr>
<td>Adobe RGB</td>
<td>2.2</td>
<td>6500K (D65)</td>
</tr>
<tr>
<td>Apple RGB</td>
<td>1.8</td>
<td>6500K (D65)</td>
</tr>
<tr>
<td>ColorMatch RGB</td>
<td>1.8</td>
<td>5000K (D50)</td>
</tr>
<tr>
<td>Wide Gamut RGB</td>
<td>2.2</td>
<td>5000K (D50)</td>
</tr>
</tbody>
</table>

**CMYK simulation profiles**

A profile that simulates colors when printing in a CMYK environment (printing machine, etc.). With DPP, you can simulate color with four types of profile.

- **Euro Standard**: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- **JMPA**: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- **JapanColor2001 type3**: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

**Rendering intent**

Rendering intents are color conversion methods when printing an image. The conversion method of each rendering intent is shown below.

- **Perceptual**: Before and after conversion, all colors are converted to maintain the relationship between colors. Even where colors slightly change, you can print a natural-looking image which has maintained color harmony. However, depending on the image, the saturation may change overall.

- **Relative Colorimetric**: There will not be much conversion to colors which are similar before and after conversion, but colors which are not similar are converted appropriately. Because there are little changes to similar colors which comprise most of an image, you can print a natural-looking image in which the saturation has not changed greatly. However, depending on the image, there are cases where the overall tone of an image changes somewhat as colors which are not similar and highlights change.
## Index

### A
- Adjust JPEG Images .................................................. 39
- Adjust TIFF Images .................................................. 39
- Adjusting
  - Adjustment Contents (Recipe) .................................. 85
  - Apply Adjustments .................................................. 84
  - Automatic Adjustment (Gradation, Luminance) ........... 49
  - Brightness ............................................................ 41, 53
  - Brightness of Highlights ......................................... 46
  - Brightness of Shadows ............................................. 46
  - Click White Balance .............................................. 44, 54
  - Color Saturation ..................................................... 47
  - Color Temperature .................................................. 45
  - Color Tone ............................................................. 47
  - Contrast ................................................................. 46, 53
  - Copy Adjustments ................................................... 84
  - Dynamic Range ...................................................... 48, 57
  - Filter Effect .......................................................... 48
  - Hue ........................................................................ 58, 59
  - Monochrome .......................................................... 47
  - Personal White Balance ............................................ 98
  - Picture Style File ..................................................... 43
  - Saturation ............................................................... 58, 59
  - Save Adjustments .................................................... 84
  - Sharpness ............................................................... 51
  - Tone Curve Adjustment ............................................ 55
  - Toning Effect .......................................................... 47, 48
  - White Balance ......................................................... 43
- Adjusting Brightness .................................................. 41
- Adjusting Tone Curve .................................................. 55
- Adjustment Contents (Recipe) ..................................... 83, 117
- Adobe RGB .............................................................. 118
- AF Points ................................................................ 17
- Apple RGB ............................................................. 118
- Arrange Images ........................................................ 30, 31
- Auto Lighting Optimizer ............................................. 50
- Automatic Adjustment (Gradation, Luminance) ........... 49
- Automatic Dust Erasure Processing ............................. 75

### B
- Basic Adjustment Tool Palette ................................. 41
- Batch Apply White Balance to Images (Personal White Balance) ................................................................. 98
- Batch Change the File Name of Images ..................... 103
- Batch Convert/Save Images (Batch Process) ............... 100
- Batch Process (Batch Save JPEG and TIFF Images) ....... 100
- Batch Process of Multiple Images
  - Change File Name .................................................... 103
  - Convert/Save (Batch Process) ................................. 100
  - Personal White Balance ........................................... 98
  - Recipe Data ........................................................... 83
  - Transfer ................................................................ 102
- Batch Settings Window ............................................. 100, 102
- Batch Transfer Images ............................................. 102
- Batch Transfer Images to Image Editing Software ....... 102
- Before/After Comparison Display ............................... 19
- bit Number ............................................................... 117
- Bookmark ............................................................... 35
- Brightness ............................................................... 53

### C
- Change File Name ....................................................... 103
- Change the Display .................................................... 10
- Changing the File Name of Images in the Order in the Main Window ........................................................... 103
- Check Mark .............................................................. 28, 29, 116
- Chromatic Aberration Correction ............................... 67
- Chrominance Noise Reduction .................................... 60
- Click White Balance ................................................ 44, 54
- CMYK Simulation ...................................................... 118
- Collection Window .................................................... 89
- Color Blur Correction ................................................ 67
- Color Chart .............................................................. 118
- Color Management (Color Matching) ........................ 117
  - Color Space ........................................................... 118
  - ICC Profiles .......................................................... 117
  - Color Management (Preferences) ............................. 111
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color saturation</td>
<td>47</td>
</tr>
<tr>
<td>Color Setting of the Monitor (Profiles)</td>
<td>111</td>
</tr>
<tr>
<td>Color Setting of the Printer (Profiles)</td>
<td>111</td>
</tr>
<tr>
<td>Color Space</td>
<td>118</td>
</tr>
<tr>
<td>Adobe RGB</td>
<td>118</td>
</tr>
<tr>
<td>Apple RGB</td>
<td>118</td>
</tr>
<tr>
<td>Color Space Setting for Each Image</td>
<td>79</td>
</tr>
<tr>
<td>ColorMatch RGB</td>
<td>118</td>
</tr>
<tr>
<td>sRGB</td>
<td>118</td>
</tr>
<tr>
<td>Wide Gamut RGB</td>
<td>118</td>
</tr>
<tr>
<td>Color Space Setting for Each Image</td>
<td>79</td>
</tr>
<tr>
<td>Color Temperature</td>
<td>45</td>
</tr>
<tr>
<td>Color Tone</td>
<td>47</td>
</tr>
<tr>
<td>ColorMatch RGB</td>
<td>118</td>
</tr>
<tr>
<td>Compatible Lenses with the Lens Aberration Correction Function</td>
<td>65</td>
</tr>
<tr>
<td>Contrast</td>
<td>46, 53</td>
</tr>
<tr>
<td>Convert One Image</td>
<td>80</td>
</tr>
<tr>
<td>Convert to JPEG or TIFF Image and Save</td>
<td>80, 100</td>
</tr>
<tr>
<td>Copy Stamp (Image Correction)</td>
<td>78</td>
</tr>
<tr>
<td>Copying and Pasting (Applying) Recipes</td>
<td>84</td>
</tr>
<tr>
<td>Correct Images (Copy Stamp Function)</td>
<td>78</td>
</tr>
<tr>
<td>Cropping</td>
<td>62</td>
</tr>
<tr>
<td>Customize toolbar</td>
<td>92</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Default Color Space Setting</td>
<td>111</td>
</tr>
<tr>
<td>Delete Images</td>
<td>34</td>
</tr>
<tr>
<td>Deleting</td>
<td></td>
</tr>
<tr>
<td>Delete Images</td>
<td>34</td>
</tr>
<tr>
<td>Delete the Software</td>
<td>115</td>
</tr>
<tr>
<td>Deleting DPP (Uninstalling)</td>
<td>115</td>
</tr>
<tr>
<td>Detailed Setting Printing (Printing with Shooting Information)</td>
<td>95</td>
</tr>
<tr>
<td>Digital Lens Optimizer</td>
<td>70</td>
</tr>
<tr>
<td>Digital Lens Optimizer mark</td>
<td>116</td>
</tr>
<tr>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>Before/After Comparison Display</td>
<td>19</td>
</tr>
<tr>
<td>Enlarged Display (Quick Check Window)</td>
<td>26</td>
</tr>
<tr>
<td>Multi-Function Preview</td>
<td>20</td>
</tr>
<tr>
<td>Single Image Display</td>
<td>31</td>
</tr>
<tr>
<td>Synchronize Preview Window</td>
<td>86</td>
</tr>
<tr>
<td>Thumbnail Display (Main Window)</td>
<td>10</td>
</tr>
<tr>
<td>Thumbnail Display and Enlarged Display (Edit Image Window)</td>
<td>87</td>
</tr>
<tr>
<td>Displaying Image Properties</td>
<td>19</td>
</tr>
<tr>
<td>Displaying Shooting Information</td>
<td>19</td>
</tr>
<tr>
<td>Distortion Correction</td>
<td>67</td>
</tr>
<tr>
<td>Downloading an Image to Your Computer</td>
<td>8</td>
</tr>
<tr>
<td>Downloading Images from a Camera</td>
<td>8</td>
</tr>
<tr>
<td>Downloading Images from a Card Reader</td>
<td>8</td>
</tr>
<tr>
<td>Downloading Images</td>
<td>8</td>
</tr>
<tr>
<td>Downloading Images from a Camera</td>
<td>8</td>
</tr>
<tr>
<td>Dust Delete Data</td>
<td>74, 75</td>
</tr>
<tr>
<td>Dust Delete/Copy Stamp Tool Palette</td>
<td>74</td>
</tr>
<tr>
<td>Dust Erasure Processing</td>
<td></td>
</tr>
<tr>
<td>Automatic Dust Erasure Processing</td>
<td>74</td>
</tr>
<tr>
<td>Dust Delete/Copy Stamp Tool Palette</td>
<td>74</td>
</tr>
<tr>
<td>Image Correction (Copy Stamp Function)</td>
<td>78</td>
</tr>
<tr>
<td>Manual Dust Erasure (Repair Function)</td>
<td>76</td>
</tr>
<tr>
<td>Dynamic Range</td>
<td>48, 57</td>
</tr>
<tr>
<td>E</td>
<td></td>
</tr>
<tr>
<td>Edit Image Window</td>
<td>87</td>
</tr>
<tr>
<td>Editing</td>
<td>119</td>
</tr>
<tr>
<td>Enlarged Display (Preview Window)</td>
<td>13</td>
</tr>
<tr>
<td>EOS Utility</td>
<td>8</td>
</tr>
<tr>
<td>Exiting DPP</td>
<td>24</td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>Filter Effect</td>
<td>48</td>
</tr>
<tr>
<td>G</td>
<td></td>
</tr>
<tr>
<td>General Settings (Preferences)</td>
<td>109</td>
</tr>
<tr>
<td>GPS mark</td>
<td>116</td>
</tr>
<tr>
<td>Grid Lines</td>
<td>17</td>
</tr>
</tbody>
</table>
## Contents

### H
- Highlight Area Warning Indicator ............................................................. 18
- Histogram Palette ................................................................................... 12
- Hue ........................................................................................................ 40, 58, 59

### I
- ICC Profiles ............................................................................................ 117
- Image Information ................................................................................... 32
- Image Marks (Image Frame Information) ................................................... 116
- Image processing (Preferences) ................................................................. 110
- Image Quality
  - Noise Reduction .................................................................................. 60

### J
- JPEG Image ............................................................................................. 39, 117

### L
- Lens Aberration Correction ..................................................................... 65
- Lens aberration correction mark ............................................................... 116
- Linear ..................................................................................................... 49
- Loading and Pasting (Applying) Recipes ................................................... 85
- Luminance Noise Reduction .................................................................... 60

### M
- Main Window ........................................................................................... 10
- Main Window (Multi-layout) ..................................................................... 15
- Main Window (Thumbnail Layout) ............................................................. 10
- Manual Dust Erasure (Repair Function) .................................................... 76
- Monochrome ............................................................................................. 47
  - Filter Effect .......................................................................................... 48
  - Toning effect ......................................................................................... 47
- Move or Copy Folders ............................................................................... 35
- Move or Copy Images ............................................................................... 34
- Multi-Function Preview .......................................................................... 20
- Multi-layout ............................................................................................. 15
- Multiple image display mark ................................................................... 116

### N
- Navigator Palette ..................................................................................... 14

### O
- Organize Images ..................................................................................... 34
- Organizing Images .................................................................................. 34
  - Delete Images ...................................................................................... 34
  - Move or Copy Folders .......................................................................... 35
  - Move or Copy Images .......................................................................... 34
  - Register Folders as Bookmarks ............................................................. 35

### P
- Palettes
  - Display Method of Palettes ................................................................ 23
  - Rearranging Palettes .......................................................................... 23
- Perceptual ............................................................................................... 118
- Peripheral Illumination Correction .......................................................... 67
- Personal White Balance ......................................................................... 98
- Picture Style ............................................................................................ 42
- Picture Style File .................................................................................... 43
- Pin ........................................................................................................... 16
- Pinned image setting mark ...................................................................... 116
- Preferences ............................................................................................. 109
  - Color Management ............................................................................ 111
  - General Settings ................................................................................. 109
  - Image processing ................................................................................ 110
  - View Settings ..................................................................................... 112
- Preview Control Panel ............................................................................ 16
- Preview Display Area ............................................................................. 15
- Preview Window ..................................................................................... 13
- Printing
  - Printing One Sheet of Paper ................................................................. 94
  - Printing with Shooting Information (Detailed Setting Printing) .......... 95
- Printing One Sheet of Paper ................................................................. 94
  - Printing with Shooting Information (Detailed Setting Printing) .......... 95

### Q
- Quick Check Window ............................................................................... 26

### R
- Rating ...................................................................................................... 28, 29
About This Instruction Manual

- It is prohibited to reproduce, in whole or part, the contents of this Instruction Manual without permission.
- Canon may change without notice the software specifications and contents of this Instruction Manual.
- The software screens and displays printed in this Instruction Manual may differ slightly from the actual software.
- The content of this Instruction Manual has been reviewed thoroughly. However, if you should notice any errors or omissions, please contact a Canon Service Center.
- Please note that irrespective of the above-mentioned, Canon does not take responsibility for the outcome of the operation of the software.

Trademarks

- Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries.
- Adobe and Photoshop are registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
- All other trademarks are the property of their respective owners.